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Installing the Operating System

Windows XP Professional is preinstalled on the computer and will be configured automatically
the first time the computer is turned on.

f} CAUTION: Do not add optional hardware devices to your computer until the operating system is
successfully installed. Doing so may cause errors and may prevent the operating system from installing

properly.

fi CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the installation process might damage the
software that runs the computer.

The first time the computer is turned on, the operating system is automatically installed. This
takes approximately 10 minutes, depending on the system hardware configuration. At the
beginning of the installation process, you are prompted to select the appropriate language for the
operating system. Read and follow the instructions that appear on the screen to complete the
installation. During this process, do not turn off your computer unless you are directed to do so.

1.0.1 Installing or Upgrading Device Drivers

To install hardware devices such as a printer, a display adapter, or network adapter after the
operating system installation is completed, the operating system needs access to the appropriate
software drivers for the devices.

When prompted for the I386 directory on the operating system CD, replace the path specification
with C:\I386 or use the browse button of the dialog box to browse the computer for the 1386
folder.

1.0.2 Creating a Bootable Diskette or USB Flash Media Device

1. Insert a diskette into the diskette drive or attach the USB device.

2. Click Start, then click My Computer.

3. Right-click the diskette drive or USB device, then click Format.

4. Select the Create an MS-DOS startup disk check box, then click Start.

5. Follow the instructions that appear on the screen.

Service Reference Guide, dc5000 360201-002 1-1



Installing the Operating System

1.1 HP Software

The Microsoft Windows XP Professional operating system is preinstalled on the computer and
will be configured automatically the first time the computer is turned on. The following HP
software will also be installed at that time on selected models:

Computer Setup Ultilities and diagnostic features

HP Support Software including device drivers

Configuration Record

Online Safety & Comfort Guide

HP Intelligent Manageability

Enhanced HP Insight Personal Edition (Diagnostics for Windows)
DMI Support

Power Management with energy saver features

Security Management tools

Software Support Management tools

Certain drivers and utilities are available only in selected languages. You can obtain the latest
version of these files, in English and selected other languages, in one of three ways:

B Support Software CD
B HP web site at www.hp.com

B Compagq Restore Plus! CD, which is supplied with many Compaq models

% Additional HP software may be required in certain situations.
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Setup Utilities and Diagnostics Features

Setup Utilities (F10) and diagnostic features provide information needed about the computer
system when contacting Customer Support. These tools can also be used to:

B Change factory default settings and to set or change the system configuration, which may be
necessary when you add or remove hardware.

B Determine if all of the devices installed on the computer are recognized by the system and
functioning properly.

B Determine information about the operating environment of the computer.

B Solve system configuration errors detected but not automatically fixed during the Power-On
Self-Test (POST).

B Establish and manage passwords and other security features.

B Establish and manage energy-saving timeouts.

All features identified in this chapter may not be available on all HP products.

Power-On Self-Test (POST)

POST is a series of diagnostic tests that runs automatically when the system is turned on. POST
checks the following items to ensure that the computer system is functioning properly:

Keyboard
Memory modules
Diskette drives

All IDE and mass storage devices

Processors

W Controllers

If the Power-On Password is set, a key icon appears on the screen while POST is running. You
will need to enter the password before continuing. Refer to Chapter 3, Section 3.1, “Initial
Configuration and Deployment,” for information on setting, deleting, or bypassing the password.

If POST finds an error in the system, an audible and/or visual message occurs. For POST error
messages and their solutions refer to Appendix C, “POST Error Messages.”
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Setup Utilities and Diagnostics Features

2.2

Computer Setup Utilities

Use Computer Setup Utilities (F10) to:

Modify or restore factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration including settings for processor,
graphics, memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives,
or LS-120 drives.

Configure the boot priority of IDE (ATA) and USB hard drive controllers.

Enable Quick Boot which is faster than Full Boot but does not run all of the diagnostic tests
run during a Full Boot. You can set your system to:

1 always Quick Boot (default);
1 periodically Full Boot (from every 1 to 30 days); or
1 always Full Boot.

Enable or disable Network Server Mode, which allows the computer to boot the operating
system when the power-on password is enabled with or without a keyboard or mouse
attached. When attached to the system, the keyboard and mouse remain locked until the
power-on password is entered.

Select POST Messages Enabled or Disabled to change the display status of Power-On
Self-Test (POST) messages. POST Messages Disabled suppresses most POST messages,
such as memory count, product name, and other non-error text messages. If a POST error
occurs, the error is displayed regardless of the mode selected. To manually switch to POST
Messages Enabled during POST, press any key (except F1 through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on
or restarted.

Enter the Asset Tag or property identification number assigned by your company to this
computer.

Enable power-on password prompting during system restarts (warm boots) as well as during
power-on.

Establish a setup password that controls access to Computer Setup (F10) Utility and the
settings described in this section.

Secure the integrated I/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

Enable or disable Master Boot Record (MBR) Security.
Enable or disable removable media boot ability.
Enable or disable removable media write ability (when supported by hardware).

Solve system configuration errors detected but not automatically fixed during the Power-On
Self-Test (POST).

Replicate your system setup by saving system configuration information on diskette and
restoring it on one or more computers.

Execute self-tests on a specified IDE (ATA) hard drive (when supported by the drive).

2-2
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Setup Utilities and Diagnostics Features

2.2.1 Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning on the computer or restarting the system. To
access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start >Shut Down >Restart
the Computer.

2. Press the F10 key as soon as the monitor light turns green.

% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

3. Select your language from the list and press the Enter key.

4. A choice of four headings appears in the Computer Setup Utilities menu: File, Storage,
Security, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit.

1 If you have made changes that you do not want applied, select Ignore Changes and
Exit.

[  To reset to factory settings, select Set Defaults and Exit. This option will restore the
original factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the ROM is saving your F10 Computer Setup
changes because the CMOS could become corrupted. It is safe to turn off all power to the computer
after you exit the F10 Setup screen.
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Setup Utilities and Diagnostics Features

2.2.2 Computer Setup Menu

Heading

Option Description
File System Information  Lists product name, processor type/speed/stepping, cache

size (L1/12), system ROM family and version, installed memory
size (number of channels (single/dual) if applicable), chassis
serial number, integrated MAC for enabled or embedded NIC
(if applicable), and asset tracking number.

About Displays copyright information.

Set Time and Date  Allows you to set system time and date.

Save to Diskette Saves system configuration, including CMOS, to a formatted
blank 1.44-MB diskette in file CPQsetup.txt. Save/Restore for
Drive Key is supported.

Restore from Restores system configuration from a diskette. Save/Restore for

Diskette Drive Key is supported.

Set Defaults and Restores factory default settings which includes clearing any

Exit established passwords.

Ignore Changes Exits Computer Setup without applying or saving any changes.

and Exit

Save Changes Saves changes to system configuration and exits Computer

and Exit Setup.

Storage Device Lists all installed BIOS controlled storage devices.
Configuration SCSI storage drives will not be listed in Computer (F10)
Setup.
When a device is selected, detailed information and options
are displayed. The following options may be presented:
Diskette Type (For legacy diskette drives only)
Identifies the highest capacity media type accepted by the
diskette drive. Options are 3.5" 1.44 MB and 5.25" 1.2 MB.
Drive Emulation (IDE devices only)
Allows you to select a drive emulation type for a storage
device. (For example, a Zip drive can be made bootable by
selecting disk emulation.)
Drive Type Emulation Options
ATAPI Zip drive ~ None (treated as Other).
Diskette (treated as diskette drive).
IDE Hard disk None (treated as Other) Disk (treated as
hard drive).
legacy diskette  No emulation options available.
IDE CD-ROM No emulation options available.
2-4 360201-002 Service Reference Guide, dc5000



Setup Utilities and Diagnostics Features

Heading Option Description
Storage Device Drive Type Emulation Options
(continued) Configuration (continued) (continued)

(continued)

ATAPI LS-120 None (treated as Other).
Diskette (treated as diskette drive).

Transfer Mode (IDE devices only)

Specifies the active data transfer mode. Options (subject to
device capabilities) are PIO 0, Max PIO, Enhanced DMA,
Ultra DMA O, and Max UDMA.

Translation Mode (/DE disks only)

Lets you select the translation mode to be used for the device.
This enables the BIOS to access disks partitioned and formatted
on other systems and may be necessary for users of older

versions of Unix (e.g., SCO Unix version 3.2). Options are
Bit-Shift, LBA Assisted, User, and Off.

A Ordinarily, the translation mode selected automatically by

the BIOS should not be changed. If the selected translation
mode is not compatible with the translation mode that was
active when the disk was partitioned and formatted, the data
on the disk will be inaccessible.

Translation Parameters (IDE disks only)

Allows you to specify the parameters (logical cylinders, heads,
and sectors per track) used by the BIOS to translate disk I/O
requests (from the operating system or an application) into
terms the hard drive can accept. Logical cylinders may not
exceed 1023. The number of heads may not exceed 255. The
number of sectors per track may not exceed 63. These fields
are only visible and changeable when the drive translation
mode is set to User.

Multisector Transfers (IDE disks only)
Specifies how many sectors are transferred per multi-sector PIO

operation. Options (subject to device capabilities) are Disable,
8, and 16.

Options

Removable Media Boot
Enables/disables ability to boot the system from removable
media.

Removable Media Write
Enables/disables ability to write data to removable media.

@y, This feature applies only to legacy diskette, (IDE/ATA)
LS-120 Superdisk, (IDE/ATA) LS-240 Superdisk, and
(IDE/ATA) PD-optical drives.

After saving changes to Removable Media Boot, the
computer will restart. Manually, turn the computer off, then
on.

*Option supported on select models.

Service Reference Guide, dc5000
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Setup Utilities and Diagnostics Features

Heading Option Description
Storage Options Primary IDE Controller *
(continued) (continued) Allows you to enable or disable the primary IDE/ATA

controller.

Secondary IDE Controller *

Allows you to enable or disable the secondary IDE/ATA
controller.

BIOS IDE DMA Transfers

Allows you to control how BIOS disk /O requests are serviced.
When “Enable” is selected, the BIOS will service all disk I/O
requests with DMA data transfers. When “Disable” is selected,
the BIOS will service all disk /O requests with PIO data

transfers.

IDE DPS Self-Test

Allows you to execute self-tests on IDE hard drives capable of
performing the Drive Protection System (DPS) self-tests.
This selection will only appear when at least one drive

capable of performing the IDE DPS self-tests is attached to the
system.

Controller Order

Allows you to specity the order of the attached hard drive
controllers. The first hard drive controller in the order will have
priority in the boot sequence and will be recognized as drive C
(if any devices are attached).

Boot Order

Allows you to specify the order in which attached peripheral
devices (such as a diskette drive, hard drive, optical drive, or
network interface card) are checked for bootable operating
system image. Each device on the list may be individually
excluded from or included for consideration as a bootable
operating system source.

MS-DOS drive lettering assignments may not apply after a
non-MS-DOS operating system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device
specified in Boot Order, restart the computer and press F9
when the monitor light turns green. After POST is completed, a
list of bootable devices is displayed. Use the arrow keys to
select the preferred bootable device and press Enter. The
computer then boots from the selected non-default device for
this one time.

Security Setup Password

Allows you to set and enables setup (administrator) password.

If the setup password is sef, it is required fo change
Computer Setup options, flash the ROM, and make changes
to certain plug and play seftings under Windows.

See the Troubleshooting Guide for more information.

Power-On
Password

Allows you to set and enable power-on password.
See the Troubleshooting Guide for more information.

*Option supported on select models.
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Setup Utilities and Diagnostics Features

Heading Option Description

Security Password Options  Allows you to specify whether the password is required for

(continued) (This selection will ~ warm boot (CTRL+ALT+DEL).
appear only if a See the Desktop Management Guide for more information.
power-on
password is set.)
Embedded Allows you to set up a password and enable/disable the
Security * embedded Security device.

See the Desktop Management Guide for more information.

System IDs Allows you to set:

* Asset tag (18-byte identifier) and ownership Tag (80-byte
identifier displayed during POST).

See Chapter 3, Deskiop Management, in this Guide.

* Chassis serial number or Universal Unique Identifier (UUID)
number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are
normally set in the factory and are used to uniquely identify
the system.)

Keyboard locale setting (for example, English or German) for
System ID entry.

Master Boot
Record Security*

Allows you to enable or disable Master Boot Record (MBR)
Security.

When enabled, the BIOS rejects all requests to write to the
MBR on the current bootable disk. Each time the computer is
powered on or rebooted, the BIOS compares the MBR of the
bootable disk to the previously saved MBR. If changes are
detected, you are given the option of saving the MBR on the
current bootable disk, restoring the previously-saved MBR, or
disabling MBR security. You must know the setup password if
one is set.

Disable MBR Security before intentionally changing the
formatting or partitioning of the current bootable disk.
Several disk utilities (such as FDISK and FORMAT) attempt to
update the MBR.

If MBR Security is enabled and disk accesses are being
serviced by the BIOS, write requests to the MBR are rejected,
causing the utilities to report errors.

If MBR Security is enabled and disk accesses are being
serviced by the operating system, any MBR change will be
detected by the BIOS during the next reboot, ondgon MBR
Security warning message will be displayed.

Save Master Boot
Record*

Saves a backup copy of the Master Boot Record of the current

bootable disk.
@y, Only appears if MBR Security is enabled.

*Option supported on select models.

Service Reference Guide, dc5000
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Setup Utilities and Diagnostics Features

Heading Option Description
Security Restore Master Restores the backup Master Boot Record to the current
(continued) Boot Record* bootable disk.

@y, Only appears if all of the following conditions are true:
MBR Security is enabled.
A backup copy of the MBR has been previously saved.

The current bootable disk is the same disk from which the
backup copy of the MBR was saved.

A Caution: Restoring a previously saved MBR after a disk
utility or operating system has modified the MBR may cause
the data on the disk to become inaccessible. Only restore a
reviously saved MBR if you are confident that the current
Eootcble disk’s MBR has been corrupted or infected with a
virus.

Device Security* Enables/disables serial ports A and B, parallel port, front USB
ports, all USB ports, system audio, network controllers (some
models), Multibay devices (some models), and SCSI controllers
(some models).

Network Service Enables/disables the computer’s ability to boot from an

Boot operating system installed on a network server. (Feature
available on NIC models only; the network controller must
reside on the PCl bus or be embedded on the system board.)

*Option supported on select models.
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Setup Utilities and Diagnostics Features

Heading Option

Description

Advanced**  Power-On Options

Allows you to set:
POST mode (QuickBoot, FullBoot, or FullBoot every 1-30 days).
POST messages (enable/disable).

F9 prompt (enable/disable). Enabling this feature will display
the text F9=Boot Menu during POST. Disabling this feature
prevents the text from being displayed but pressing F9 will still
access the Shortcut Boot (Order) Menu screen. See Storage >
Boot Order for more information.

F10 prompt (enable/disable). Enabling this feature will
display the text F10=Setup during POST. Disabling this
feature prevents the text from being displayed but pressing
F10 will still access the Setup screen.

F12 prompt (enable/disable). Enabling this feature will
display the text F12=Network Service Boot during POST.
Disabling this feature prevents the text from being displayed
but pressing F12 will still force the system to attempt booting
from the network.

Option ROM* prompt (enable/disable). Enabling this feature
will cause the system to display a message before loading
options ROMs.

Fan idle mode* allows you to set the idle speed to 1 (default),
2, 3, or 4 (fastest). Higher speeds will provide more cooling
during idle, but will be louder.

Remote wakeup boot source (remote server/local hard drive).

After Power Loss (off/on): After power loss, if you connect your
computer to an electric power strip and would like to turn on
power to the computer using the switch on the power strip, set
this option to ON.

If you turn off power to your computer using the switch on a

power strip, you will not be able to use the suspend/sleep
feature or the Remote Management features.

* Available on select models.

**These options should be used by advanced users only.
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Heading

Option

Description

Advanced* *
(continued)

Power-On Options
(continued)

Allows you to set: (continued)

POST Delay (in seconds) (enable/disable). Enabling this
feature will add a user-specified delay to the POST process.
This delay is sometimes needed for hard disks on some PCI
cards that spin up very slowly; so slowly that they are not ready
to boot by the time POST is finished. The POST delay also gives
you more time to select F10 to enter Computer (F10) Setup.

I/O APIC Mode (enable/disable). Enabling this feature will
allow Microsoft Windows Operating system to run optimally.
This feature must be disabled for certain non-Microsoft
Operating Systems to work properly.

ACPI/USB Buffers @ Top of Memory (enable/disable).
Enabling this feature places USB memory buffers at the top of
memory. The advantage of remapping is that it allows space in
the DOS Compatibility Hole range, below TMB, to be made
available for additional PCl plug-in cards that need option
ROM space. The disadvantage is that a popular memory
manager, HIMEM.SYS, does not work properly when USB
buffers are at top of memory AND the system has 64 KB or less
of RAM.

Hot-Pluggable MultiBay Floppy* (enable/disable). Enabling
this feature allows you to hot-plug a MultiBay floppy into a
system running Windows 2000 or XP.

BIOS Wakeup*

Allows you to set the computer to turn on automatically at a
time you specify.

Onboard Devices

Allows you to set resources for or disable onboard system
devices (serial port, parallel port, or diskette controller).

PCI Devices

Lists currently installed PCl devices and their IRQ settings.

Allows you to reconfigure IRQ settings for these devices or to
disable them entirely. These settings have no effect under an
APIC-based operating system.

Bus Options*

Allows you to enable or disable:

PCl bus mastering, which allows a PCl device to take control of
the PCl bus.

PCI VGA palette snooping, which sets the VGA palette
snooping bit in PCl configuration space; only needed when
more than one graphics controller is installed.

PCl SERR# generation.

ECC support allows hardware-based error correction for
ECC-capable memories.

*Available on select models.

**These options should be used by advanced users only.
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Heading Option Description
Advanced* Device options Allows you to set:
(continued) Printer mode (bi-directional, EPP+ECP, output only).

Num Lock state at power-on (off/on).
S5 Wake on LAN (enable/disable).
Processor cache (enable/disable).
Hyper-Threading* (enable/disable).

ACPI S3* support (enable/disable). S3 is an ACPI sleep state
that some add-in hardware options may not support.

If the ACPI S3 support option is not presented, the other ACPI
S3 options (ACPI S3 Video REPOST, AXPI S3 Hard Disk
Reset, and ACPI S3 PS2 Mouse Wakeup) will not be
available.

ACPI S3 Video REPOST* (enable/disable). This feature reruns
the video option ROM on a boot from the S3 state.

ACPI S3 Hard Disk Reset* (enable/disable). Resets the hard
disk on a boot from the S3 sleep state.

ACPI S3 PS2 Mouse Wakeup* (enable/disable). Allows the
mouse to wake the system from the S3 sleep state.

Unique Sleep State Blink Patterns*. Allows you to choose an
LED blink pattern that uniquely identifies each sleep state.

Frame Buffer Size* Allows you to specify amount of system
memory dedicated to the embedded graphics frame buffer. The
AUTO setting attempts to optimize the frame buffer size
depending on the amount of total system memory.

Monitor Tracking (enable/disable). Allows ROM to save
monitor asset information.

Spread Spectrum* (enable/disable) allows system clocks to run
with a spread spectrum.

NIC PXE Option ROM Download (enable/disable). The BIOS
contains an embedded NIC option ROM to allow the unit to
boot through the network to a PXE server. This is typically used
to download a corporate image to a hard drive. The NIC
option ROM takes up memory space below TMB commonly
referred to as DOS Compatibility Hole (DCH) space. This
space is limited. This F10 option will allow users to disable the
downloading of this embedded NIC option ROM thus giving
more DCH space for additional PCl cards which may need
option ROM space. The default will be to have the NIC option

ROM enabled.
PCI VGA Displayed only if there are multiple PCI video adapters in the
Configuration system. Allows you to specify which VGA controller will be the

“boot” or primary VGA controller.

* Available on select models.
**These options should be used by advanced users only.
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2.3

2.3.1

Diagnostics for Windows

The Diagnostics for Windows (DFW) utility is a component of Intelligent Manageability that
allows you to view information about the hardware and software configuration of the computer
while running Microsoft Windows. It also allows you to perform hardware and software tests on
the subsystems of the computer.

When you invoke Diagnostics for Windows, the current configuration of the computer is shown
on the Overview screen. There is access from this screen to several categories of information
about the computer and the Test tab. The information in every screen of the utility can be saved
to a file or printed.

To test all subsystems, you must log in as the administrator. If you do not log in as the
administrator, you will be unable to test some subsystems. The inability to test a subsystem will
be indicated by an error message under the subsystem name in the Test window or by shaded
check boxes that cannot be selected.

Use Diagnostics for Windows in the following instances to:

B Determine if all the devices installed on the computer are recognized by the system and
functioning properly. Running tests is optional but recommended after installing or
connecting a new device.

B Third party devices not supported by HP may not be detected. Save, print, or display the
information generated by the utility.

Detecting Diagnostics for Windows

Some computers ship with the Diagnostics for Windows preloaded, but not preinstalled.
To determine whether Diagnostics for Windows is installed:
1. Access the location of the Diagnostics icons:

In Windows XP Home or Windows XP Professional, select Start > Control Panel >
Performance and Maintenance.

2. If icons for Configuration Record and Diagnostics for Windows are present, the Diagnostics
for Windows utility is installed. If the icons are not present, the utility is either not preloaded
or not installed.
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2.3.2 Installing Diagnostics for Windows

If Diagnostics for Windows is not preloaded, you can download the Diagnostics for Windows
SoftPaq from the following Web site:

http://www.hp.com/support/files

Once the software has been downloaded onto the hard drive it may be installed by performing
these steps:

1. Close all Windows applications.
2. Install the Diagnostics for Windows utility:

ad In Windows XP, select Start > Setup Software icon. Select Diagnostics for Windows
> Next button, then follow the instructions on the screen.

[ If the Setup Software icon is not on the Desktop or in the Start menu, run the Setup
program from the C:\CPQAPPS\DIAGS directory or select Start > Run and type the
following in the command line: C:\CPQAPPS\DIAGS\SETUP.

3. Click Next to install Diagnostics for Windows.

4. After the program has finished installing, you may be prompted to restart the computer, or it
may automatically restart. If prompted, click Finish to restart the computer or Cancel to exit
the program. You must restart the computer to complete the installation of Diagnostics for
Windows.

If you want to upgrade an existing version of Diagnostics for Windows installed on the computer,
visit http://www.hp.com/support/files and click on an applicable product. Locate the desired
software and download the latest version. Execute the downloaded file and select Repair to
update the installed version. This will cause the new version to overwrite the old version.

2.3.3 Using Categories in Diagnostics for Windows

To use categories:

1. Click Start > HP Information Center > Diagnostics for Windows. You can also select the
Diagnostics for Windows icon, located in the Control Panel.

The screen displays the overview of the computer hardware and software.

1  In Windows 2000 Professional, select Start > Settings > Control Panel, then select
Diagnostics for Windows.

3 In Windows XP Home and Windows XP Professional, select Start > Control Panel >
Performance and Maintenance, then select Diagnostics for Windows.

2. For specific hardware and software information, select a category from the Categories
pull-down menu or the appropriate icon on the toolbar.

% As the cursor moves over the toolbar icons, the corresponding category name is displayed.

3. To display more detailed information in a selected category, click More in the Information
Level box in the lower left corner of the window or click Level at the top of the screen and
select More.

Service Reference Guide, dc5000 360201-002 2-13


http://www.hp.com/support/files
http://www.hp.com/support/files

Setup Utilities and Diagnostics Features

4. Review, print, and/or save this information as desired.

1 To print the information, click File > Print. Select one of the following options:
Detailed Report (All Categories), Summary Report (All Categories), or Current
Category. Click OK to print the report you selected.

1 To save the information, click File > Save As. Select one of the following options:
Detailed Report (All Categories), Summary Report (All Categories), or Current
Category. Click OK to save the report you selected.

5. To exit Diagnostics for Windows, click File, and then click Exit.

Menu Bar—File, Categories, Navigation, Level, Tab, Help

At the top of the Diagnostics for Windows screen is the Menu Bar consisting of six pull-down
menus. Selecting an item will provide the following information on the system:

B File—Save As, Print, Printer Setup, Exit
B Categories

1  System—System board, ROM, date, and time
Asset Control—Asset tag, system serial number, and processor
Input Devices—Keyboard, mouse, and joystick(s)
Communication—Ports
Storage—Storage drives
Graphics—Graphics
Memory—System board and Windows memory
Multimedia—Optical storage (CD, DVD, and so on) and audio
Windows—Windows
Architecture—PCI Device
Resources—IRQ, I/0, and Memory Map
Health—Status of system temperature and hard drives

Miscellaneous—CMOS, DMI, BIOS, System, Product Name, and Serial Number

o0 dddooo o ddd

B Navigation—Previous Category (F5), Next Category (F6)

Level—Less (F7), More (F8) <information on the screen>
B Tab

[ Overview—Displays general information about the computer. This window is displayed
when first starting the utility. The left side of the window shows hardware information,
while the right side shows software information.

1 Test—Allows you to choose various parts of the system to test. You can also choose the
type of test and testing mode.

[ Status—Displays the status of each test in progress. You can cancel testing by clicking
the Cancel Testing button.

1 Log—Displays a log of tests for each device.

[ Error—Displays any errors that occurred during device testing. The window lists the
device being tested, the type and number of errors, and the error code.
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B Help—Contents, How to use Help, About

2.3.4 Running Diagnostic Tests in Diagnostics for Windows

To run diagnostic tests:
1. Click Start > HP Information Center > Diagnostics for Windows.
Alternately, you can access Diagnostics for Windows via the control panel.

The screen displays the overview of the computer hardware and software. Five tabs are
displayed below the row of icons: Overview, Test, Status, Log, and Error.

2. Click the Test tab, or click Tab at the top of the screen and select Test.
3. Select one of the following options:

1 Quick Test—Runs a quick, general test on each device. Requires no user intervention if
Unattended Mode is selected.

1 Complete Test—Runs maximum testing of each device. The user can select Interactive
Mode or Unattended Mode.

1 Custom Test—Runs only the tests you select. To select specific devices or tests, find the
device in the list, then select the check box beside each test. When selected, a red check
mark is displayed in the box. Some tests selected may require user intervention.

% To test all subsystems, you must log in as the administrator. If you do not log in as the
administrator, you will be unable to test some subsystems. The inability to test a subsystem will
be indicated by an error message under the subsystem name in the Test window or by shaded
boxes that cannot be checked.

4. Select Interactive Mode or Unattended Mode. In Interactive Mode, the diagnostic software
will prompt you for input during tests that require it. Some tests require interaction and will
display errors or halt testing if selected in conjunction with Unattended Mode.

1 Interactive Mode provides maximum control over the testing process. You determine
whether the test passed or failed and may be prompted to insert or remove devices.

1 Unattended Mode does not display prompts. If errors are found, they are displayed when
testing is complete.

5. Click the Begin Testing button at the bottom of the window. Test Status is displayed,
showing the progress and result of each test. For more details on the tests run, click the Log
tab or click Tab at the top of the screen and select Log.

6. To view a test report, select one of three tabs:
0 Status—Summarizes the tests run, passed, and failed during the current testing session.

1 Log—Lists tests run on the system, the numbers of times each test has run, the number
of errors found on each test, and the total run time of each test.

1 Error—Lists all errors found on the computer with their error codes.
7. To save a test report:
1 Select the Log tab Save button to save a Log tab report.

1 Select the Error tab Save button to save an Error tab report.
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8. To print a test report:

1 If the report is on the Log tab, select File > Save As, then print the file from the selected
folder.

[ If the report is on the Error tab, select the Error tab Print button.

9. If errors are found, click the Error tab to display more detailed information and
recommended actions.

10. Click Print or save the error information for future reference.

11. To exit Diagnostics for Windows, click File > Exit.

Configuration Record

The Configuration Record utility is a windows-based information-gathering tool that gathers
critical hardware and software information from various computer subsystems. The information
includes such things as the ROM, asset tag, processor, physical drives, PCI devices, memory,
graphics, operating system version number, operating system parameters, and the operating
system startup files to give a complete view of the computer. Configuration Record provides a
means for automatically identifying and comparing configuration changes, and has the ability to
maintain a configuration history. The information can be saved as a history of multiple sessions.

This utility allows the resolution of problems without taking the computer offline and assists in
maximizing the computer availability. The information obtained by the utility is useful in
troubleshooting system problems, and streamlines the service process by enabling quick and
easy identification of system configurations.

The utility displays it findings in a Now.log file. If the original Base.log file is present in the
cpqdiags directory, the Base.log file is displayed next to the Now.log file in a split window with
the differences between the two highlighted in the color red.

Installing Configuration Record

The Configuration Record is part of Diagnostics for Windows and is automatically installed at
the same time as Diagnostics for Windows.

2.4.2 Running Configuration Record

SN

To run this program:
1. Click Start > HP Information Center > Configuration Record.

Alternately, you can access Diagnostics for Windows via the control panel.

The Configuration Record utility has two view options: Show Changed Items Only and Show
All. The default view is Show Changed Items Only, therefore all the text is displayed in the
color red since it shows only the differences. Switching to Show All displays the complete,
comprehensive view of the system.

2. The default view is Show Changed Items Only. To view all the information gathered by
Configuration Record, click View at the top of the window and select Show All, or click the
Show All Items icon.
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3. To save the information in the left or right window, select File > Save Window File and
then select Left Window File or Right Window File.

% Saving the configuration of the computer periodically allows the user to keep a history of the
configuration. This history may be useful to you in the future if the system ever encounters a
problem that needs debugging.

4. To exit Configuration Record, click File, then click Exit.

2.5 Remote Diagnostics Enabling Agent

This utility provides a Web browser interface to Diagnostics for Windows. It enables remote
control of the diagnostics and facilitates easy transfer of computer information from remote
machines to a service provider.

The Remote Diagnostics Enabling Agent captures hardware configuration and provides the
ability to perform tests remotely to diagnose computer problems. In addition, the Remote
Diagnostics Enabling Agent identifies any computer hardware device problems signaled by the
HP Management Agents. These hardware devices are automatically selected for testing by the
Remote Diagnostics Enabling Agent.

% The Remote Diagnostics Enabling Agent only works if Diagnostics for Windows is also
installed.

The Remote Diagnostics Enabling Agent is pre-loaded on some computers and is available
through a SoftPaq at http://www.hp.com under Support and Drivers.

2.5.1 Installing or Upgrading Remote Diagnostics
Enabling Agent

1. Visit http://www.hp.com/support/files and click on the applicable product.
2. Locate the appropriate software and download the latest version.

3. Execute the downloaded file. If you are upgrading an existing version, select Repair for the
new version to overwrite the old version.

2.5.2 Running the Remote Diagnostics Enabling Agent

1. Select the Remote Diagnostics icon located in the Control Panel.

% The Remote Diagnostics Enabling Agent allows you to run Diagnostic Test or the Configuration
Record in a browser window. Both of these utilities can be run remotely or locally.

2. To exit Remote Diagnostics, click File and then click Close.

2.6 Protecting the Software

To protect software from loss or damage, you should keep a backup copy of all system software,
applications, and related files stored on the hard drive. See the operating system or backup utility
documentation for instructions on making backup copies of data files.
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2.7 Restoring the Software

The Windows operating system and software can be restored to its original state by using the
Restore CD. See the Restore CD for complete instructions on using this feature.
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3.1

Desktop Management

HP Intelligent Manageability provides standards-based solutions for managing and controlling
desktops, workstations, and notebook PCs in a networked environment.

The key capabilities and features of desktop management are:
Initial configuration and deployment

Remote system installation

Software updating and management

ROM flash

Asset tracking and security

Fault notification and recovery

Support for specific features described in this guide may vary by model or software version.

Initial Configuration and Deployment

HP computers come with a preinstalled system software image. After a brief software
“unbundling” process, the computer is ready to be used.

A customized software image may be deployed by:

B Installing additional software applications after unbundling the preinstalled software image.

B Using software deployment tools, such as Altiris Deployment Solutions, to replace the
preinstalled software with a customized software image.

B Using a disk cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment and
processes. The PC Deployment section of the Solutions and Services Web site
(http://h18000.www 1.hp.com/solutions/pcsolutions) provides information to help you select the
best deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with
recovery of system software, configuration management and troubleshooting, and power
management.
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3.2

3.3

3.3.1

Remote System Installation

Remote System Installation allows you to start and set up your system using the software and
configuration information located on a network server by initiating the Preboot Execution
Environment (PXE). The Remote System Installation feature is usually used as a system setup
and configuration tool, and can be used for the following tasks:

B Formatting a hard drive.
B Deploying a software image on one or more new PCs.

B Remotely updating the system BIOS in flash ROM. See Section 3.4.1, “Remote ROM
Flash.”

B Configuring the system BIOS settings.

To initiate Remote System Installation, press F12 when the F12 = Network Service Boot
message appears in the lower-right corner of the HP logo screen. Follow the instructions on the
screen to continue the process. The default boot order is a BIOS configuration setting that can be
changed to always attempt to PXE boot.

Software Updating and Management

HP provides several tools for managing and updating software on desktops and
workstations—HP Client Manager Software, Altiris Client Management Solutions, System
Software Manager; Proactive Change Notification; and Subscriber's Choice.

HP Client Manager Software

HP Client Manager Software (HP CMS) assists HP customers in managing the hardware aspects
of their client computers with features that include:

B Detailed views of hardware inventory for asset management

B PC health check monitoring and diagnostics

B Proactive notification of changes in your hardware environment
|

Web-accessible reporting of business critical details such as machines with thermal
warnings, memory alerts, and more

B Remote updating of system software such as device drivers and ROM BIOS
B Remote changing of boot order

For more information on the HP Client Manager, visit
http://h18000.www 1.hp.com/im/client_mgr.html.

3.3.2 Altiris Client Management Solutions

HP and Altiris have partnered to provide comprehensive, tightly integrated systems management
solutions to reduce the cost of owning HP client PCs. HP Client Manager Software is the
foundation for additional Altiris Client Management Solutions that address:

B Inventory and Asset Management
1 SW license compliance
1 PC tracking and reporting

d Lease contract, fixing asset tracking

3-2
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B Deployment and Migration
1 Windows 2000/XP migration
1  System deployment
1 Personality migrations

B Help Desk and Problem Resolution
d Managing help desk tickets
1 Remote troubleshooting
1 Remote problem resolution
1 Client disaster recovery

B Software and Operations Management
d  Ongoing desktop management
1 HP system SW deployment
1  Application self-healing

For more information and details on how to download a fully-functional 30-day evaluation
version of the Altiris solutions, visit http://h18000.www 1.hp.com/im/prodinfo.html#deploy.

On selected desktop and notebook models, an Altiris management agent is included as part of the
factory loaded image. This agent enables communication with the Altiris Development Solution
which can be used to complete new hardware deployment or personality migration to a new
operating system using easy-to-follow wizards. Altiris solutions provide easy-to-use software
distribution capabilities. When used in conjunction with System Software Manager, or HP Client
Manager Software, administrators can also update ROM BIOS and device driver software from a
central console.

For more information, visit http://h18000.www 1.hp.com/im/index.html.

3.3.3 System Software Manager

System Software Manager (SSM) lets you update system-level software on multiple systems
simultaneously. When executed on a PC client system, SSM detects both hardware and software
versions, then updates the appropriate software from a central repository, also known as a file
store. Driver versions that are supported by SSM are denoted with a special icon on the driver
download Web site and on the Support Software CD. To download the utility or to obtain more
information on SSM, visit http://h18000.www 1.hp.com/im/ssmwp.html.

3.3.4 Proactive Change Notification (PCN)

This feature is available on select models.

The HP Proactive Notification program uses the Subscriber's Choice Web site to proactively and
automatically:

B Send you Product Change Notification (PCN) emails informing you of hardware and
software changes to most commercial computers and servers, up to 60 days in advance.

B Send you email containing Customer Bulletins, Customer Advisories, Customer Notes,
Security Bulletins, and Driver alerts for most commercial computers and servers.
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You create your own profile to ensure that you only receive the information relevant to your IT
environment. To learn more about HPPN and create your custom profile, visit
http://www.hp.com/go/pen.

3.3.5 Subscriber’s Choice

Subscriber’s Choice is a client-based service from HP. Based on your profile, HP will supply
you with personalized product tips, feature articles, and/or driver and support
alerts/notifications. Subscriber’s Choice Driver and Support Alerts/Notifications will deliver
e-mails notifying you that the information you subscribed to in your profile is available for
review and retrieval. To learn more about Subscriber’s Choice and create a custom profile, visit
http://www.hp.com/go/pcn.

3.4 ROM Flash

The computer comes with a reprogrammable flash ROM (read only memory). By establishing a
setup password in Computer Setup (F10) Utility, you can protect the ROM from being
unintentionally updated or overwritten. This is important to ensure the operating integrity of the
computer. Should you need or want to upgrade your ROM, you may:

B  Order an upgraded ROMPaq diskette from HP.
B Download the latest ROMPaq images from http://www.hp.com/support.

CAUTION: For maximum ROM protection, be sure to establish a setup password. The setup password
prevents unauthorized ROM upgrades. System Software Manager allows the system administrator to set
the setup password on one or more PCs simultaneously. For more information, visit

http://www.hp.com/go/ssm.

3.4.1 Remote ROM Flash

Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP
computers directly from the centralized network management console. Enabling the system
administrator to perform this task remotely, on multiple computers and personal computers,
results in a consistent deployment of and greater control over HP PC ROM images over the
network.

% The computer must be powered on, or turned on through Remote Wakeup, to take advantage of
Remote ROM Flash.

For more information on Remote ROM Flash, refer to the HP Client Manager Software or
System Software Manager at http://h18000.www 1.hp.com/im/prodinfo.html.

3.4.2 HPQ Flash

The HPQFlash utility is used to locally update or restore the system ROM on individual PCs
through a Windows operating system.

For more information on HPQFlash, visit http://www.hp.com/support/files and enter the name
of the computer when prompted.
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3.4.3 FailSafe Boot Block ROM

The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash
failure, for example, if a power failure were to occur during a ROM upgrade. The Boot Block is a
flash-protected section of the ROM that checks for a valid system ROM flash when power to the
system is turned on.

B If the system ROM is valid, the system starts normally.

B If the system ROM fails the validation check, the FailSafe Boot Block ROM provides
enough support to start the system from a ROMPaq diskette, which will program the system
ROM with a valid image.

% Some models also support recovery from a ROMPaq CD. ISO ROMPaq images are included
with selected models in the downloadable ROM softpags.

When the bootblock detects an invalid system ROM, the System Power LED blinks RED §
times, one every second, followed by a 2-second pause. Also 8 simultaneous beeps will be heard.
A Boot Block recovery mode message is displayed on the screen (some models).

To recover the system after it enters Boot Block recovery mode, complete the following steps:

1. If there is a diskette in the diskette drive or a CD in the CD drive, remove the diskette and
CD and turn off the power.

2. Insert a ROMPaq diskette into the diskette drive or, if permitted on this computer, a
ROMPaq CD into the CD drive.

3. Turn on the computer.

If no ROMPaq diskette or ROMPaq CD is found, you will be prompted to insert one and
restart the computer.

If a setup password has been established, the Caps Lock light will turn on and you will be
prompted to enter the password.

4. Enter the setup password.

If the system successfully starts from the diskette and successfully reprograms the ROM,
then the three keyboard lights will turn on. A rising tone series of beeps also signals
successful completion.

5. Remove the diskette or CD and turn the power off.
6. Turn the power on again to restart the computer.

The following table lists the various keyboard light combinations used by the Boot Block ROM
(when a PS/2 keyboard is attached to the computer), and explains the meaning and action
associated with each combination.

Service Reference Guide, dc5000 360201-002 3-5



Desktop Management

Keyboard Light Combinations Used by Boot Block ROM

Failsafe Boot Keyboard Keyboard
Block Mode LED Color LED Activity State/Message
Num Lock Green On ROMPaq diskette not present, is bad, or
drive not ready.
Caps Lock Green On Enter password.
Num, Caps, Green Blink on in Keyboard locked in network mode.
Scroll Lock sequence,
one-at-a-time—
N,C,SL
Num, Caps, Green On Boot Block ROM Flash successful. Turn

Scroll Lock

power off, then on to reboot.

@y, Diagnostic lights do not flash on USB keyboards.

3.4.4 Replicating the Setup

This procedure gives an administrator the ability to quickly and easily copy one setup
configuration to other computers of the same model. To replicate the setup:

1. Access the Computer Setup Utilities (F10) menu.

2. Click File > Save to Diskette. Follow the instructions on the screen.

% This requires a diskette drive or a supported USB flash media device, such as Drive Key.

3. To replicate the configuration, click File > Restore from Diskette, and follow the

instructions on the screen.

System Software Manager (SSM) may also be used to distribute setup configurations to multiple
computers. For more information, see http://www.hp.com/go/ssm.

3.4.5 Dual-State Power Bution

With Advanced Configuration and Power Interface (ACPI) enabled for Windows 2000 and
Windows XP, the power button can function either as an on/off switch or as a suspend button.
The suspend feature does not completely turn off power, but instead causes the computer to enter
a low-power standby. This allows you to quickly power down without closing applications and
to quickly return to the same operational state without any data loss.

To change the power button’s configuration, complete the following steps:

1. In Windows 2000, left click on the Start Button, then select Settings > Control Panel >

Power Options.

In Windows XP, left click on the Start Button, then select Control Panel > Power

Options.

2. In the Power Options Properties, select the Advanced tab.

3. In the Power Button section, select the desired power button setting.

3-6
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After configuring the power button to function as a suspend button, press the power button to put
the system in a very low power state (suspend). Press the button again to quickly bring the
system out of suspend to full power status. To completely turn off all power to the system, press
and hold the power button for four seconds.

CAUTION: Do not use the power button to turn off the computer unless the system is not responding;
turning off the power without operating system interaction could cause damage to or loss of data on the

hard drive.

3.4.6 Power Management
Power Management is a feature that saves energy by shutting down certain components of the

computer when they are not in use, saving energy without having to shut down the computer.

With Advanced Configuration and Power Interface (ACPI) enabled for Windows 2000 and
Windows XP, timeouts (the period of inactivity allowed before shutting down these components)
can be enabled, customized, or disabled using the operating system.

1. In Windows 2000, left click on the Start Button, then select Settings > Control Panel >
Power Options.

In Windows XP, left click on the Start Button, then select Control Panel > Power
Options.

2. In the Power Options Properties, select the Power Schemes tab.
3. Select the desired power scheme settings.

Use Display Properties to establish, modify, or disable Power Management settings for the
monitor. To access Display Properties, right click on the Windows Desktop, then choose
Properties.

3.4.7 World Wide Web Site

When making the transition to new or revised operating systems, it is important to implement the
support software designed for that operating system. If you plan to run a version of Microsoft
Windows that is different from the version included with your computer, you must install
corresponding device drivers and utilities to ensure that all features are supported and
functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software
easier. You can download the software from http://www.hp.com/support. The Web site contains
the latest device drivers, utilities, and flashable ROM images needed to run the latest Microsoft
Windows operating system on your HP computer.

3.4.8 Building Blocks and Partners

HP management solutions integrate with other systems management applications, and are based
on industry standards, such as:

B Web-Based Enterprise Management (WBEM)
Windows Management Interface (WMI)
Wake on LAN Technology

ACPI

SMBIOS
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3.5

B Pre-boot Execution (PXE) support

Asset Tracking and Security

Asset tracking features incorporated into the computer provide key asset tracking data that can be
managed using HP Insight Manager, HP Client Manager or other system management
applications. Seamless, automatic integration between asset tracking features and these products
enables you to choose the management tool that is best suited to your environment and to
leverage your investment in existing tools.

HP also offers several solutions for controlling access to valuable components and information.
Security features available on select models help to prevent unauthorized access to the internal
components of the personal computer. By disabling parallel, serial, or USB ports, or by disabling
removable media boot capability, you can protect valuable data assets. Memory Change alerts
can be automatically forwarded to system management applications to deliver proactive
notification of tampering with a computer’s internal components.

Protect Tools is available as an option on select systems.

Use the following utilities to manage security settings on your HP computer:

B Locally, using the Computer Setup Utilities. See the Computer Setup (F10) Utility Guide
included with the computer for additional information and instructions on using the

Computer Setup Utilities.

B Remotely, using HP Client Manager or System Software Manager. This software enables the
secure, consistent deployment and control of security settings from a simple command-line

utility.

The following table and sections refer to managing security features of your computer locally
through the Computer Setup Ultilities (F10).

Security Features Overview

Feature

Purpose

How It Is Established

Removable Media Boot
Control

Prevents booting from the
removable media drives
(available on select drives).

From the Computer Setup
Utilities (F10) menu.

Serial, Parallel, USB, or
Infrared Interface Control

Prevents transfer of data
through the integrated serial,
parallel, USB (universal serial
bus), or infrared interface.

From the Computer Setup
Utilities (F10) menu.

Power-On Password

Prevents use of the computer
until the password is entered.
This can apply to both initial
system startup and restarts.

From the Computer Setup
Utilities (F10) menu.

Setup Password

Prevents reconfiguration of the
computer (use of the Computer
Setup Utilities) until the
password is entered.

From the Computer Setup
Utilities (F10) menu.

For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.

Support for security features may vary depending on your specific computer configuration.
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Security Features Overview (Continued)

Feature

Purpose

How It Is Established

Drivelock

Prevents unauthorized access
to the data on specific hard
drives. This feature is available
on select models only.

From the Computer Setup
Utilities (F10) menu.

Embedded Security

Prevents unauthorized access
to the data on specific hard
drives. This feature is
available on select models
only.

From the Computer Setup
Utilities (F10) menu.

Master Boot Record Security

May prevent unintentional or
malicious changes to the
Master Boot Record of the
current bootable disk, and
provides a means of
recovering the “last known

good” MBR.

From the Computer Setup
Utilities (F10) menu.

Memory Change Alerts

Detects when memory
modules have been added,
moved, or removed; notifies
user and system administrator.

For information on enabling
Memory Change Alerts,
refer to the online Intelligent
Manageability Guide.

Ownership Tag

Displays ownership
information, as defined by the
system administrator, during
system startup (protected by
setup password).

From the Computer Setup
Utilities (F10) menu.

Cable Lock Provision

Inhibits access to the interior of
the computer to prevent
unwanted configuration
changes or component
removal. Can also be used to
secure the computer to a fixed
object to prevent theft.

Install a cable lock to secure
the computer to a fixed
object.

Security Loop Provision

Inhibits access to the interior of
the computer to prevent
unwanted configuration
changes or component
removal.

Install a lock in the security
loop to prevent unwanted
configuration changes or
component removal.

For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.

Support for security features may vary depending on your specific computer configuration.
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3.5.1 Password Security

The power-on password prevents unauthorized use of the computer by requiring entry of a
password to access applications or data each time the computer is turned on or restarted. The
setup password specifically prevents unauthorized access to Computer Setup, and can also be
used as an override to the power-on password. That is, when prompted for the power-on
password, entering the setup password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log in to
all network systems to perform maintenance without having to know the power-on password,
even if one has been established.

3.5.2 Establishing a Setup Password Using Computer Setup

Establishing a setup password through Computer Setup prevents reconfiguration of the computer
(use of the Computer Setup (F10) utility) until the password is entered.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security, then select Setup Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.

3.5.3 Establishing a Power-On Password Using Computer Setup

Establishing a power-on password through Computer Setup prevents access to the computer
when power is turned on, unless the password is entered. When a power-on password is set,
Computer Setup presents Password Options under the Security menu. Password options include
Password Prompt on Warm Boot. When Password Prompt on Warm Boot is enabled, the
password must also be entered each time the computer is rebooted.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security, then Power-On Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.
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Entering a Power-On Password
To enter a power-on password, complete the following steps:
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. When the key icon appears on the monitor, type your current password, then press Enter.

% Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.

Entering a Setup Password

If a setup password has been established on the computer, you will be prompted to enter it each
time you run Computer Setup.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the key icon appears on the monitor, type the setup password, then press the Enter
key.

% Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.
Changing a Power-On or Setup Password

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.
To change the setup password, run Computer Setup.

2. To change the Power-On password, go to step 3.

To change the Setup password, as soon as the computer is turned on, press and hold the F10
key until you enter Computer Setup. Press Enter to bypass the title screen, if necessary.

% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.
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3. When the key icon appears, type your current password, a slash (/) or alternate delimiter
character, your new password, another slash (/) or alternate delimiter character, and your new
password again as shown:
current password/new password/new password

% Type carefully; for security reasons, the characters you type do not appear on the screen.

4. Press the Enter key.

The new password takes effect the next time you turn on the computer.

Refer to the “National Keyboard Delimiter Characters” section in this chapter for information
about the alternate delimiter characters. The power-on password and setup password may also be
changed using the Security options in Computer Setup.

Deleting a Power-On or Setup Password

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.
To delete the setup password, run Computer Setup.

2. To delete the Power-On password, go to step 3.

To delete the Setup password, as soon as the computer is turned on, press and hold the F10
key until you enter Computer Setup. Press Enter to bypass the title screen, if necessary.

% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the key icon appears, type your current password followed by a slash (/) or alternate
delimiter character as shown:
current password/

4. Press the Enter key.

Refer to “National Keyboard Delimiter Characters” section in this chapter for information about
the alternate delimiter characters. The power-on password and setup password may also be
changed using the Security options in Computer Setup.
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National Keyboard Delimiter Characters

Each keyboard is designed to meet country-specific requirements. The syntax and keys that you

use for changing or deleting your password depend on the keyboard that came with your

computer.

National Keyboard Delimiter Characters
Arabic / Greek Russian
Belgian = Hebrew Slovakian
BHCSY* Hungarian Spanish
Brazilian / ltalian Swedish/Finnish
Chinese / Japanese Swiss
Czech Korean Taiwanese
Danish Latin American Thai
French ! Norwegian Turkish
French Canadian ¢ Polish U.K. English
German Portuguese U.S. English

* For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia

Clearing Passwords

To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external

devices, and disconnect the power cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external devices connected to the

computer.

WARNING: To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to
disconnect the power cord from the wall outlet, and allow the internal system components to cool before

touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied fo the
system board even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object. See the Safety & Regulatory Information guide for more

information.

3. Remove the computer cover or access panel.

4. Locate the header and jumper.

Service Reference Guide, dc5000
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% The password jumper is green so that it can be easily identified. For assistance locating the
password jumper and other system board components, see the Illustrated Parts Map (IPM) for
that particular system.

5. Remove the jumper from pins 1 and 2. Place the jumper on either pin 1 or 2, but not both, so
that it does not get lost.

6. Replace the computer cover or access panel.
7. Reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

9. To establish new passwords, repeat steps 1 through 4, replace the password jumper on pins 1
and 2, then repeat steps 6 through 8. Establish the new passwords in Computer Setup. Refer
to the Computer Setup (F10) Utility Guide on the Documentation CD for Computer Setup
instructions.

3.5.4 Drivelock

DriveLock is an industry-standard security feature that prevents unauthorized access to the data
on specific hard drives. DriveLock has been implemented as an extension to Computer Setup. It
is only available on certain systems and only when DriveLock-capable hard drives are detected.

DriveLock is intended for HP customers for whom data security is the paramount concern. For
such customers, the cost of the hard drive and the loss of the data stored on it is inconsequential
when compared with the damage that could result from unauthorized access to its contents. In
order to balance this level of security with the practical need to accommodate a forgotten
password, the HP implementation of DriveLock employs a two-password security scheme. One
password is intended to be set and used by a system administrator while the other is typically set
and used by the end-user. There is no “back-door” that can be used to unlock the drive if both
passwords are lost. Therefore, DriveLock is most safely used when the data contained on the
hard drive is replicated on a corporate information system or is regularly backed up.

In the event that both DriveLock passwords are lost, the hard drive is rendered unusable. For
users who do not fit the previously defined customer profile, this may be an unacceptable risk.
For users who do fit the customer profile, it may be a tolerable risk given the nature of the data
stored on the hard drive.
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Using Drivelock

The DriveLock option appears under the Security menu in Computer Setup. The user is
presented with options to set the master password or to enable DriveLock. A user password must
be provided in order to enable DriveLock. Since the initial configuration of DriveLock is
typically performed by a system administrator, a master password should be set first. HP
encourages system administrators to set a master password whether they plan to enable
DriveLock or keep it disabled. This will give the administrator the ability to modify DriveLock
settings if the drive is locked in the future. Once the master password is set, the system
administrator may enable DriveLock or choose to keep it disabled.

If a locked hard drive is present, POST will require a password to unlock the device. If a
power-on password is set and it matches the device’s user password, POST will not prompt the
user to re-enter the password. Otherwise, the user will be prompted to enter a DriveLock
password. Either the master or the user password may be used. Users will have two attempts to
enter a correct password. If neither attempt succeeds, POST will continue but the drive will
remain inaccessible.

Drivelock Applications

HP recommends that the system administrator be responsible for configuring the hard drive
which would involve, among other things, setting the DriveLLock master password. In the event
that the user forgets the user password or the equipment is passed on to another employee, the
master password can always be used to reset the user password and regain access to the hard
drive.

HP recommends that corporate system administrators who choose to enable DriveL.ock also
establish a corporate policy for setting and maintaining master passwords. This should be done to
prevent a situation where an employee intentionally or unintentionally sets both DriveLock
passwords before leaving the company. In such a scenario, the hard drive would be rendered
unusable and require replacement. Likewise, by not setting a master password, system
administrators may find themselves locked out of a hard drive and unable to perform routine
checks for unauthorized software, other asset control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling
DriveLock. Users in this category include personal users or users who do not maintain sensitive
data on their hard drives as a common practice. For these users, the potential loss of a hard drive
resulting from forgetting both passwords is much greater than the value of the data DriveLock
has been designed to protect. Access to Computer Setup and DriveLock can be restricted through
the Setup password. By specifying a Setup password and not giving it to end users, system
administrators are able to restrict users from enabling DriveLock.
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3.5.5 Master Boot Record Security

The Master Boot Record (MBR) contains information needed to successfully boot from a disk
and to access the data stored on the disk. Master Boot Record Security may prevent unintentional
or malicious changes to the MBR, such as those caused by some computer viruses or by the
incorrect use of certain disk utilities. It also allows you to recover the “last known good” MBR,
should changes to the MBR be detected when the system is restarted.

To enable MBR Security, complete the following steps:
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security > Master Boot Record Security > Enabled.
4. Select Security > Save Master Boot Record.
5. Before exiting, click File > Save Changes and Exit.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.

% Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot
prevent changes that may occur while the operating system is running.

Each time the computer is turned on or restarted, the BIOS compares the MBR of the current
bootable disk to the previously saved MBR. If changes are detected and if the current bootable
disk is the same disk from which the MBR was previously saved, the following message is
displayed:

1999—Master Boot Record has changed.
Press any key to enter Setup to configure MBR Security.
Upon entering Computer Setup, you must
B Save the MBR of the current bootable disk;
B Restore the previously saved MBR; or
B Disable the MBR Security feature.
You must know the setup password, if one exists.

If changes are detected and if the current bootable disk is not the same disk from which the MBR
was previously saved, the following message is displayed:

2000—Master Boot Record Hard Drive has changed.
Press any key to enter Setup to configure MBR Security.
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Upon entering Computer Setup, you must

W Save the MBR of the current bootable disk; or
B Disable the MBR Security feature.

You must know the setup password, if one exists.

In the unlikely event that the previously saved MBR has been corrupted, the following message
is displayed:

1998—Master Boot Record has been lost.
Press any key to enter Setup to configure MBR Security.
Upon entering Computer Setup, you must
H Save the MBR of the current bootable disk; or
B Disable the MBR Security feature.

You must know the setup password, if one exists.

3.5.6 Before You Partition or Format the Current Bootable Disk

Ensure that MBR Security is disabled before you change partitioning or formatting of the current
bootable disk. Some disk utilities, such as FDISK and FORMAT, attempt to update the MBR. If
MBR Security is enabled when you change partitioning or formatting of the disk, you may
receive error messages from the disk utility or a warning from MBR Security the next time the
computer is turned on or restarted. To disable MBR Security, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

% If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security > Master Boot Record Security > Disabled.

4. Before exiting, click File > Save Changes and Exit.

3.5.7 Cable Lock Provision

The rear panel of the computer accommodates a cable lock so that the computer can be
physically secured to a work area.

For illustrated instructions, please see the Removal and Replacement Chapter for the specific
chassis.

Service Reference Guide, dc5000 360201-002 3-17



Desktop Management

3.5.8 Fingerprint Identification Technology

3.6

3.6.1

Eliminating the need to enter user passwords, HP Fingerprint Identification Technology tightens
network security, simplifies the login process, and reduces the costs associated with managing
corporate networks. Affordably priced, it is not just for high-tech, high-security organizations
anymore.

Support for Fingerprint Identification Technology varies by model.

For more information, visit http://www.hp.com/security.

Fault Notification and Recovery

Fault Notification and Recovery features combine innovative hardware and software technology
to prevent the loss of critical data and minimize unplanned downtime.

If the computer is connected to a network managed by HP Client Manager, the computer sends a
fault notice to the network management application. With HP Client Manager Software, you can
also remotely schedule diagnostics to automatically run on all managed PCs and create a
summary report of failed tests.

Drive Protection System

The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in
select HP computers. DPS is designed to help diagnose problems that might result in
unwarranted hard drive replacement.

When HP computers are built, each installed hard drive is tested using DPS, and a permanent
record of key information is written onto the drive. Each time DPS is run, test results are written
to the hard drive. Your service provider can use this information to help diagnose conditions that
caused you to run the DPS software. Refer to the Troubleshooting Guide for instructions on
using DPS.

3.6.2 Surge-Tolerant Power Supply

An integrated surge-tolerant power supply provides greater reliability when the computer is hit
with an unpredictable power surge. This power supply is rated to withstand a power surge of up
to 2000 volts without incurring any system downtime or data loss.

3.6.3 Thermal Sensor

The thermal sensor is a hardware and software feature that tracks the internal temperature of the
computer. This feature displays a warning message when the normal range is exceeded, which
gives you time to take action before internal components are damaged or data is lost.
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4.1

4.2

4.2.1

SN

Ultra ATA Drive Guidelines and Features

Ultra ATA Jumpers

Ultra ATA drives are configured by means of jumper settings. Factory-installed drives ship with
the jumpers preset to the cable-select mode; therefore, no jumper setting changes are required on
factory pre installed, replacement, or option drives. With cable-select, the drive is configured as
either Master (Drive/Device 0) or Slave (Drive/Device 1) by its physical attachment to the cable.

If you purchase a third-party hard drive, refer to the documentation included with the drive kit to
ensure proper cable installation and configuration.

All drives on a controller channel need to have their jumpers either in the cable-select mode or
have the individual drive jumper installed on the appropriate Master (Drive/Device 0) or Slave
(Drive/Device 1) position.

Ultra ATA Cables

When installing a second device on either the primary or secondary controller, you must use an
industry standard 80-conductor Ultra ATA cable for optimal performance. These cables have a
maximum length of 18 inches and a maximum distance of 6 inches between the two devices for a
two-drive cable.

Drives operating at speeds faster than those of the Ultra ATA-33 devices require
industry-standard 40-pin, 80-conductor cables to maintain the higher data transfer rates possible
with the improved technology.

When using Ultra ATA-133, -100, -66, and slower -33 drives in the same system, each drive will
operate at its appropriate data transfer rate.

Cable Layout

The faces of industry-standard cable connectors are color coded for easy recognition:
B System board connector = blue face
B Device 0 connector = black face

B Device 1 connector = gray face

The color code of an industry-standard cable is valid only if the drive’s jumper is in the
cable-select position.
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Single-Drive Cable
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Board
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Two-Drive Cable
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Black
Face
Device 1 Device 0
(slave) (master)
LE cr
T T
Gray Black
Face Face

On a two-drive cable, the Drive/Device 0 connector is always the farthest one from the system
board connector and the Drive/Device 1 connector is always the closest to the system board

connector.

Some cables may be labeled “Drive 0” instead of “Device 0” and “Drive 1” instead of

“Device 1.

4.3 Drive Installation Guidelines

SN

Most computer system boards have two ATA (IDE) controller channels with a dedicated
connector for each controller. One controller is designated as the primary and the other as the

secondary controller.

Each of the two controllers can have up to two devices attached to it. Each computer system may
therefore have a maximum of four ATA/ATAPI drives. All drives are connected to these
controllers using an industry-standard 80-conductor cable.

The industry standard 1.44 MB diskette drive has its own separate channel and is not included as

a part of the maximum four drives.

Any drive attached to a controller must have a drive designation. If only a single drive is
connected to a controller and its jumper is in the cable-select position, it is designated as the
Master Drive (Drive/Device 0) by its attachment to the Drive/Device 0 cable position. If two
cable-selected drives are connected to a single controller, one will be designated by its
attachment to the cable as the Master (Drive/Device 0) and the other as Slave (Drive/Device 1).

For optimal performance of a computer system, all drives need to be attached to the ATA
controllers in a specified sequence. This sequence is determined by the device class of the drives

and by specific attach sequence rules.

360201-002
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4.3.1 Device Classes

In order to determine the best drive attach sequence, ATA/ATAPI drives are segregated into four
different classes based upon the bandwidth demands they place on an ATA controller. The most
demanding devices are in Class 1 and the least demanding are in Class 4.

Class 1 Class 2 Class 3 Class 4
Hard High Speed Optical Storage Magnetic
Drives Optical Drives Drives Storage Drives

ATA-100 DVD R/W CD-ROM LS-120
ATA-66 DVD-CD R/W CD-ROM Tape
ATA-33 Zip

General Attach Guidelines

B The lower the device class number, the faster the device and the more bandwidth required.

B Drives installed in the Device O positions on both the primary and secondary controllers
receive the greatest possible bandwidth.

B The bootable ATA hard drive should always be installed on the primary controller in the
Device 0 position.

4.3.2 Attach Sequence Rules by Class Priority

Drives should be attached in the sequence shown for optimum performance starting at

position @.
(4] (1)
(3) (2]
-
Primary (4] 1)
Controller*
[T cr
I T T
Secondary (3] (2]
Controller
cr
T q e
Device 1 Device 0

*If there are three or more devices, two or more of which are hard drives, two hard drives should
be attached to the primary controller first before following the General Attach Sequence Rule.
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The attach sequence rule may also be stated in table format:

General Attach Sequence Rule*

Sequence Description
1 The lowest class drive - bootable hard drive recommended.
2 If only two drives, the last drive goes here; otherwise the lowest class of the

remaining drives.

3 If only three drives, attach the final drive here. If a fourth drive exists, attach the
lowest class drive here.

4 If there is a fourth drive, attach the final drive here - the drive with the highest
class number of all devices.

*|f there are three or more devices, two or more of which are hard drives, two hard drives should
be attached to the primary controller first before following the General Attach Sequence Rule.

The rules allow for:

B Keeping the hard drive on a separate controller channel maximizes drive performance until a
fourth device is added.

B Keeping the hard drives and removable media drives on separate controller channels
maximizes compatibility.

B Keeping the hard drive and the writable optical drive on separate controller channels
maximizes optical drive reliability.

4.3.3 Attach Sequence Worksheet

Use the worksheet below for obtaining optimum system performance when setting up a
computer with multiple drives. Use the General Attach Sequence Rule to determine the best
drive installation sequence.

Attach Sequence Worksheet

Position Controller Device
Device Name Device Class Number Name Number

Two examples of how to use the worksheet are:
B Three device installation

B Four device installation
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Example 1: Three Device Installation Sample

A system has three devices: Ultra ATA-100 hard drive, CD-ROM drive, and a DVD drive. Using
the Device Class Table in Section 4.3.1, the devices may be identified as:

B Ultra ATA-100 hard drive = Class 1
B DVD drive = Class 2
H CD-ROM drive = Class 3

Attach Sequence Worksheet - Three Device Installation (Sample)

Device Position Controller Device
Device Name Class Number Name Number
Ultra ATA-100 hard drive 1 o Primary 0
DVD drive 2 (2] Secondary 0
CD-ROM drive 3 (3] Secondary 1
(4] (1]
(3) (2]
Primary (4] (1]
Controller*
r
5 & :
Secondary (3] 2]
Controller
o 7 7
Device 1 Device 0

Example 2: Four Device Installation Sample

A system has four devices: Ultra ATA-100 hard drive, Ultra ATA-100 hard drive, DVD-CDR/W
drive, and a ZIP-250 drive. Using the Device Class Table in Section 4.3.1, the devices may be
reidentified as:

Ultra ATA-100 hard drive = Class 1
Ultra ATA-100 hard drive = Class 1
DVD-CDR/W drive = Class 2
ZIP-250 drive = Class 4
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Attach Sequence Worksheet - Four Device Installation (Sample)

Device Position Controller Device
Device Name Class Number Name Number
Ultra ATA-100 hard drive 1 o Primary 0
DVD-CDR/W drive 2 (2] Secondary 0
ZIP-250 drive 4 (3] Secondary 1
Ultra ATA-100 hard 1 (4] Primary 1
drive*

*If there are three or more devices, two or more of which are hard drives, two hard drives should
be attached to the primary controller first before following the General Attach Sequence Rule.

(4]

®

Primary
Controller*

(2]

L]

Secondary
Controller

L]

4 © 4 ©
0 ® g ©

Device 1 Device 0

4.3.4 Additional Drive Application Notes

4.4

B  When replacing a hard drive, the replacement should be of the same type (Ultra ATA -33,
-66, or -100) as that being removed to retain the same level of performance.

B  When Ultra ATA and SCSI hard drives are mixed in the same system, the Ultra ATA drive
will become the boot drive unless the boot order is changed in Computer Setup (F10 Setup).

SMART

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP
Personal Computers have built-in drive failure prediction that warns the user or network
administrator of an impending failure or crash of the hard drive. The SMART drive tracks fault
prediction and failure indication parameters such as reallocated sector count, spin retry count,
and calibration retry count. If the drive determines that a failure is imminent, it generates a fault

alert.
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4.5

Drive Capacities

The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that
may be properly accessed by the operating system. A single hard drive may therefore be
subdivided into a number of unique drive partitions in order to make use of all of its space.

The table that follows identifies the capabilities and restrictions imposed on the computer by the
combinations of file and operating systems.

Microsoft to Drive Manufacturer Size Conversion Table*

Drive Size as Identified by Microsoft

Operating System

Drive Size as Identified by
Drive Manufacturers

2GB 2.1 GB

4 GB 4.3 GB

32 GB 34.4 GB
64 GB 68.7 GB
128 GB 137 GB

27B 2.199 1B

*Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

Maximum Size

Service Reference Guide, dc5000

File Controller
System Type Operating System Partition Drive
FAT 32 ATA Windows 2000/ XP 32 GB 128 GB
FAT 32 SCSI Windows 2000/ XP 32 GB 278
NTFS ATA Windows NT/2000/XP 128 GB 128 GB
NTFS SCSI Windows NT/2000/XP 218 218
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Identifying the Chassis, Routine Care, and
Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures
and precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source voltage is always applied to the
system board. You must disconnect the power cord from the power source before opening the computer
to prevent system board or component damage.

5.1 Chassis Designations

5.1.1 Microtower (uT)
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5.1.2 Small Form Factor (SFF)
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5.2 Electrostatic Discharge Information

A sudden discharge of static electricity from your finger or other conductor can destroy
static-sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but damage
occurs. An electronic device exposed to electrostatic discharge (ESD) may not appear to be
affected at all and can work perfectly throughout a normal cycle. The device may function
normally for a while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

5.2.1 Generating Static

The following table shows that:
B Different activities generate different amounts of static electricity.

B Static electricity increases as humidity decreases.

Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500 V 15,000 V 35,000 V
Walking across vinyl floor 3,000V 5,000 V 12,000 V
Motions of bench worker 400V 800V 6,000 vV
Removing DIPs* from plastic tube 400V 700 vV 2,000V
Removing DIPs* from vinyl tray 2,000V 4,000 V 11,500 V
Removing DIPs* from Styrofoam 3,500V 5,000 V 14,500 V
Removing bubble pack from PCB 7,000 V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

% 700 volts can degrade a product.

5.2.2 Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to
prevent damage to electric components and accessories.

B To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

B Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.
Place items on a grounded surface before removing them from their container.
Always be properly grounded when touching a sensitive component or assembly.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.
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5.2.3 Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

B Wrist straps are flexible straps with a maximum of one-megohm + 10% resistance in the
ground cords. To provide proper ground, a strap must be worn snug against bare skin. The
ground cord must be connected and fit snugly into the banana plug connector on the
grounding mat or workstation.

B Heel straps/Toe straps/Boot straps can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats,
use them on both feet with a maximum of one-megohm + 10% resistance between the
operator and ground.

Static Shielding Protection Levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

5.2.4 Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

B Cover the work surface with approved static-dissipative material. Provide a wrist strap
connected to the work surface and properly grounded tools and equipment.

B Use static-dissipative mats, foot straps, or air ionizers to give added protection.

B Handle electrostatic sensitive components, parts, and assemblies by the case or PCB
laminate. Handle them only at static-free work areas.

B Turn off power and input signals before inserting and removing connectors or test
equipment.

B Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

B Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

B Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

5.2.5 Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:
Antistatic tape

Antistatic smocks, aprons, or sleeve protectors

Conductive bins and other assembly or soldering aids

Conductive foam

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

Static-dissipative table or floor mats with hard tie to ground

Field service kits
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Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

5.3 Routine Care

5.3.1 General Cleaning Safety Precautions

1.
2.

3.
4,
5.
6.

Never use solvents or flammable solutions to clean the computer.

Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

Always unplug the computer when cleaning with liquids or damp cloths.
Always unplug the computer before cleaning the keyboard, mouse, or air vents.
Disconnect the keyboard before cleaning it.

Wear safety glasses equipped with side shields when cleaning the keyboard.

5.3.2 Cleaning the Computer Case

Follow all safety precautions in Section 5.3.1, “General Cleaning Safety Precautions,” before
cleaning the computer.

To clean the computer case, follow the procedures described below:

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it
with a cloth or swab dampened with clear water.

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

After cleaning, always wipe the unit with a clean, lint-free cloth.

Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.
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5.3.3 Cleaning the Keyboard

Follow all safety precautions in Section 5.3.1, “General Cleaning Safety Precautions,” before
cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Section
5.3.2, “Cleaning the Computer Case.”

When cleaning debris from under the keys, review all rules in Section 5.3.1, “General Cleaning
Safety Precautions,” before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under

the keys.

B Visible debris underneath or between the keys may be removed by vacuuming or shaking.

B Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.

B If you remove a key, use a specially designed key puller to prevent damage to the keys. This

tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are
improperly removed or installed, the keyboard may not function properly.

Cleaning under a key may be done with a swab moistened with isopropyl alcohol and
squeezed out. Be careful not to wipe away lubricants necessary for proper key functions. Use
tweezers to remove any fibers or dirt in confined areas. Allow the parts to air dry before
reassembly.

5.3.4 Cleaning the Monitor

Wipe the monitor screen with a clean cloth moistened with water or with a towelette
designed for cleaning monitors. Do not use sprays or aerosols directly on the screen; the
liquid may seep into the housing and damage a component. Never use solvents or flammable
liquids on the monitor.

To clean the monitor body follow the procedures in Section 5.3.2, “Cleaning the Computer
Case.”

5.3.5 Cleaning the Mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull
out any debris from the ball socket and wipe the ball with a clean, dry cloth before
reassembly.

To clean the mouse body, follow the procedures in Section 5.3, “Routine Care.”

5-6
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5.4

5.4.1

Service Considerations

Listed below are some of the considerations that you should keep in mind during the disassembly
and assembly of the computer.

Power Supply Fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is off enly when the computer is turned off or the power cable has been
disconnected.

The cooling fan is always on when the computer is either in the “On,” “Standby,” or “Suspend” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

5.4.2 Tools and Software Requirements

To service the computer, you need the following:
B Torx T-15 screwdriver (Compaq screwdriver with bits, PN 161946-001)

B Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)
B Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)
B Phillips #2 screwdriver

B Diagnostics software

5.4.3 Screws

SN

The screws used in the computer are not interchangeable. They may have standard or metric
threads and may be of different lengths. If an incorrect screw is used during the reassembly
process, it can damage the unit. HP strongly recommends that all screws removed during
disassembly be kept with the part that was removed, then returned to their proper locations.

Metric screws have a black finish.
U.S. screws have a silver finish.

As each subassembly is removed from the computer, it should be placed away from the work
area to prevent damage.
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5.4.4 Cables and Connectors

5.4.5

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during
insertion or removal from the connector. Handle cables by the connector whenever possible. In
all cases, avoid bending or twisting the cables, and ensure that the cables are routed in such a way
that they cannot be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location during
the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration.
This applies to failed drives as well as replacement spares.

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

Avoid dropping drives from any height onto any surface.

If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard
drive while the computer is on or in standby mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Section 5.2, “Electrostatic Discharge Information.”

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have
magnetic fields such as monitors or speakers.

5.4.6 Lithium Coin Cell Battery

The battery that comes with the computer provides power to the real-time clock and has a
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING: This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140°F (60°C).

CAUTION: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste.
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Removal and Replacement Procedures—
icrotower (uT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper
service. After completing all necessary removal and replacement procedures, run the Diagnostics
utility to verify that all components operate properly.

% Not all features listed in this guide are available on all computers.

6.1 Preparation for Disassembly

See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation,” for initial
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 6.2,
“External Security Devices,” Section 6.2.1, “Installing a Cable Lock,” and Section 6.2.2,
“Installing a Padlock™).

. Close any open software applications.

. Exit the operating system.

B~ W

. Remove any diskette or compact disc from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

fi CAUTION: Turn off the computer before disconnecting any cables.

f} CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

% During disassembly, label each cable as you remove it, noting its position and routing. Keep all
screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong
screw in an application may damage the unit.
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6.2 External Security Devices

6.2.1 Installing a Cable Lock

The cable lock may be used to secure the computer access panel to the chassis and, at the same
time, secure the computer to a fixed object.
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6.2.2 Installing a Padlock

A padlock may be used by itself to secure the access panel to the computer chassis. A padlock
may also be used with a security cable to secure the computer to a fixed object.
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6.3 Access Panel

1. Prepare the computer for disassembly (Chapter 6, “Removal and Replacement Procedures—
Microtower (uT) Chassis”).

CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that
the power cord is disconnected from the electrical outlet.

2. Loosen the captive thumbscrew @ that secures the access panel to the computer chassis.

3. Slide the access panel @ back about 1 inch (2.5 cm), then lift it off the unit.

% You may want to lay the computer on its side to install internal parts. Be sure the side with the
access panel and pull grip is facing up.

To install the access panel, reverse the removal procedure.

6-4 360201-002 Service Reference Guide, dc5000



Removal and Replacement Procedures— Microtower (uT) Chassis

6.4 Front Bezel

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the access panel (Section 6.3, “Access Panel”).

3. To remove the front bezel, press in on the two bottom tabs on the left side of the bezel @ so
that they release from the chassis. Then press in on the upper tab on the left side of the bezel
@ 50 that it releases from the chassis. The bezel will rotate out slightly from left to right.

CAUTION: Do not over-rotate or try to pull the bezel off at this point, otherwise you may break the
remaining hooks on the inside of the bezel.
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4. Press down on the upper right corner of the bezel to release the hook that secures the top of
the bezel to the chassis @. Continue to rotate the bezel, then push the bezel to the left to
release the right side latches and rotate the bezel off the chassis from left to right @.
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To reinstall the front bezel,
1. Position the chassis in the upright position.

2. Insert the two hooks on the right side of the bezel @ into the rectangular holes on the chassis
then rotate the bezel into place @ so that the three tabs on the left side of the bezel and the
single tab on the upper right corner of the bezel snap into the slots on the chassis.
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6.5 Front Drive Bezels
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the access panel (Section 6.3, “Access Panel”).

3. Remove the front bezel (Section 6.4, “Front Bezel”).

6.5.1 5.25" Drive Bezel Blank

Press the two retaining tabs on the inside of the large bezel @ towards the outside of the bezel to
release the bezel blank. At the same time, pull the bezel blank in @ to remove it from the front

bezel.

#

To install a bezel blank, reverse the removal procedure.
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6.5.2 Diskette Drive Bezel

Press the two upper @ or the two lower @ tabs for the diskette drive bezel towards the center of
the drive bezel and push the bezel out to remove it from the front bezel.

To install a bezel or a bezel blank, reverse the removal procedure.

6.5.3 3.5" Drive Bezel Blank

Press the two upper @ or the two lower @ tabs for the 3.5" drive bezel towards the center of the
3.5" drive bezel and push the bezel blank out to remove it from the front bezel.

To install a bezel blank, reverse the removal procedure.
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6.6 Memory Modules

CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation
resulting from having incompatible metals in contact with each other.

CAUTION: Static electricity can damage the electronic components of the computer or optional cards.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. Refer to Chapter for more information.

CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so
may damage the module.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components
to cool before touching.

3. Open both latches of the memory module socket @, and insert the memory module into the
socket @. Begin by installing a module into the socket nearest the preinstalled module, and
install the modules following the numerical order of the sockets.

% A memory module can be installed in only one way. Match the notch on the module with the tab
on the memory socket.

4. Push the module down into the socket, ensuring that the module is fully inserted and
properly seated. Make sure the latches are in the closed position ©.

5. Repeat steps 3 and 4 for any additional modules that you want to install.

To reassemble the computer, reverse the removal procedure.
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6.7 Expansion Cards

6.7.1 Expansion Slot Cover

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

3. On the rear of the computer, slide the slot cover lock up to access the expansion slot covers.

For instructions on PCI expansion cards, see Section 6.7.2, “PCI Expansion Card.”
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6.7.2 PCI Expansion Card

For preliminary steps, see Section 6.7.1, “Expansion Slot Cover.”
1. Lay the computer on its side with the open side facing up.
If replacing a PCI expansion card go to step 2.
If installing a PCI expansion card for the first time in a computer, skip to step 5.

2. When removing an expansion card from a standard expansion socket, hold the card at each
end, and carefully rock it back and forth until the connectors pull free from the socket.

3. Pull the expansion card straight up from the socket @ then away from the inside of the
chassis @ to maneuver the card out of the computer.

fi CAUTION: Be sure not to scrape the card against the other components.

f} CAUTION: After removing an expansion card, you must replace it with a new card or cover the open
slot (for example, with a metal slot cover or a piece of cardboard taped in place) for proper cooling of
infernal components during operation.

4. Store the old card in the anti-static packaging that contained the new card.

5. If you are installing a PCI expansion card for the first time in this computer you will need to
remove the correct expansion slot cover at this time.
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6. When installing an expansion card, hold the card just above the expansion slot on the system
board then move the card toward the rear of the chassis so that the bracket on the card is
aligned with the open slot on the rear of the chassis @.

7. Press the card straight down into the expansion slot on the system board @.

5 //
" _..i i i'l'

% Press firmly on the card so that the whole connector seats properly in the expansion card slot.

8. Slide the slot cover lock down toward the expansion card brackets and slot covers to secure
them in place.

% Installing the access panel will secure the slot cover lock.

Service Reference Guide, dc5000 360201-002 6-13



Removal and Replacement Procedures— Microtower (uT) Chassis

6.8 Drives

The computer supports up to six drives that may be installed in various configurations.

This Section describes the procedure for replacing or upgrading the storage drives. A Torx T-15
screwdriver is needed to remove and install the guide screws on a drive.

CAUTION: Make sure personal files on the hard drive are backed up to an external storage device
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard
drive, you will need to run the Restore CD to load the Compaq factory-installed files.

6.8.1 Drive Positions

Drive Positions

ltem Description Item Description

o Optical drive* (4] Bay for optional 3.5" drive

(2] Second optical drive (5] Primary hard drive

(3] Diskette drive (optional) (6] Optional hard drive

:‘An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD-R/RW, or CD-RW/DVD Combo
rive.
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6.8.2 Removing a Drive

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

3. Remove the front bezel (Section 6.4, “Front Bezel”).

4. Disconnect the power and data cables from the back of the drive, as shown in the following
illustrations.

Disconnecting Optical Drive Cables
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Disconnecting Hard Drive Cables

-
re

Releasing the Drives

5. A latch drive bracket with release tabs secures the drives in the drive bay. Lift the release tab

on the latch drive bracket @ for the drive you want to remove, then slide the drive from its
drive bay @.

6. Remove the four guide screws (two on each side) from the old drive. You will need these
screws to install a new drive.
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6.8.3 Installing a Drive

CAUTION: To prevent loss of work and damage to the computer or drive:

B If you are inserting or removing a hard drive, shut down the operating system properly, then turn off
the computer. Do not remove a hard drive while the computer is on or in standby mode.

B Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, refer to
Chapter 5 for more information

B Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

1. Install four guide screws (two on each side) into the new drive. The screws help guide the
drive into its proper position in the bay.

[ If this is a new installation, guide screws are provided on the front of the chassis under
the front bezel.

1 If this is a replacement drive, use the screws taken from the old drive.

% There are a total of eight extra guide screws on the front of the chassis. Four have U.S. threads
and four have metric threads. Metric screws have a black finish. U.S. threaded screws have a
silver finish. Make sure to install the appropriate guide screws into the drive.

2. Align the guide screws with the guide slots, then slide the drive into the drive bay, making
sure it is fully seated.
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3. Reconnect the power and data cables to the drive as shown in the following illustrations.

% Refer to Chapter 4, “Ultra ATA Drive Guidelines and Features,” and Section 4.3, “Drive
Installation Guidelines,” for information on attaching the cabling to get optimum performance.

Connecting Optical Drive Cables

Connecting Diskette Drive Cables
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Connecting Hard Drive Cables

4. Install the front bezel (Section 6.4, “Front Bezel”).
5. Install the access panel (Section 6.3, “Access Panel”).

6. Turn on the computer.

If you replaced the primary hard drive, the restore CD may be used to restore the operating
system, software drivers, and/or any software applications that were preinstalled on the
computer. Follow the instructions in the guide included with the restore CD. When the restore
process has completed, reinstall any personal files that were backed up before replacing the hard
drive.
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6.9 Chassis Fan

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

3. Disconnect the power cable that connects the chassis fan to the system board @.
4. Remove the four screws from the rear of the chassis @ that secure the fan.

5. Remove the fan from the chassis ©.

To install the chassis fan, reverse the removal procedure.
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6.10 Front 1/0 Panel Housing Assembly

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

3. Disconnect three attaching cables from the system board: the power switch/LED cable, the
front USB cable, and the front audio cable.

4. Remove the two screws @ that secure the housing to the chassis and then pull the housing @
away from the chassis.

To install the housing assembly, reverse the removal procedures.
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6.11 Front 1/0 Devices

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

3. Remove the front I/O panel assembly (Section 6.10, “Front I/O Panel Housing Assembly”).
4. Remove the two screws @ that hold the USB and audio port assembly in place.
5. Remove the I/O device assembly from the I/O panel @ by pushing it out of the housing.

To install the I/O devices, reverse the removal procedures and then reinstall the housing
assembly.
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6.12 Power Switch Assembly

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

3. Remove the front I/O panel assembly (Section 6.10, “Front I/O Panel Housing Assembly”).

4. Squeeze the switch holder retaining clips together @ and push the switch assembly out of the
front I/O panel housing.

5. From the inside of the I/O panel assembly, spread the clips @ that secure the LEDs in place
and then push the LEDs out of the retainers from the front side.

6. If necessary, compress the retaining clips on the LED holders and push the holders out of the
front of the I/O panel housing.

7. Remove the switch from the switch holder ©.

8. To install the power switch assembly install the switch into the switch holder.
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9. Place the switch holder with switch installed into the inside of the front I/O panel housing
and position the legs of the retaining clip into the clip slots. Press firmly so that the clips will
penetrate the slot openings and latch into place. If one clip will not easily engage, it may be
necessary to use the end of a ball point pen (or another thin, stiff object) to compress the clip
leg while inserting it into the clip slot.

10. Push the LEDs into the their retainers. The power LED (having the blue and black leads)
should be to the right when viewed from the front of the computer.
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11. Reconnect the housing assembly to the front of the chassis and reconnect the cables to the
system board.
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6.13 Processor and Heatsink

1.

Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table

0 N N B kW

to make it easier to work on (Section 6.3, “Access Panel”).

. Disconnect the heatsink fan cable from the system board.
. Release the tension from the heatsink @.

. Remove the retaining clips @.

. Remove the heatsink from atop the processor ©.

. Open the ZIF socket lever @.

. Remove the processor @.

To install the processor and heatsink:

1.

. Press down on the processor while rotating and locking the ZIF socket handle in place.

AN L W

Insert the processor into the ZIF socket.

. Refresh the thermal grease between the heatisnk and processor if necessary.
. Install the heatsink and latch it in place.
. Connect the heatsink fan control to the system board.

. Replace the access panel and reconnect the computer.
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6.14 System Board

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

3. Remove all PCI expansion boards (Section 6.7.2, “PCI Expansion Card”).
4. Disconnect all cables connected to the system board, noting their location for reinstallation.

5. Compress the system board tray handle @ to release the latch and slide the system board tray
towards the front of the computer @ to free it from the back of the chassis.

To install the system board, slide the tray assembly into the chassis and press down on the two
places shown in the drawing @ while sliding the tray into its locked position @.
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6.15

> &

Battery

The battery that comes with your computer provides power to the real-time clock and has a
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and
burns if the battery is not handled properly. To reduce the risk of personal injury:
Bl Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C)

|

B Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or
water.

|

Replace the battery only with the HP/Compagq spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Troubleshooting
Guide for information on backing up the CMOS settings.

Batteries, battery packs, and accumulators should not be disposed of together with the general
household waste. In order to forward them to recycling or proper disposal, please use the public
collection system or return them to HP/Compagq, their authorized pariners, or their agents.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following
instructions to replace the battery:
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6.15.1 Type 1 Battery Holder

1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.
4. Replace the computer cover or access panel (Section 6.3, “Access Panel”).
5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.
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6.15.2 Type 2 Battery Holder

1. To release the battery from its holder, squeeze the metal clamp that extends above one edge
of the battery @. When the battery pops up, lift it out.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip &
with the positive side up. Push the other edge down until the clamp snaps over the other edge
of the battery.

% After the battery has been replaced, use the following steps to complete this procedure.

3. Replace the computer cover or access panel (Section 6.3, “Access Panel”).
4. Plug in the computer and turn on power to the computer.

Reset the date and time, your passwords, and any special system setups, using Computer Setup.
Refer to the Computer Setup (F10) Utility Guide.
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6.15.3 Type 3 Battery Holder

1. To release the battery from its holder, press back lever @ that extends above one edge of the
battery.

2. When the battery pops up, lift it out @.

3. To insert the new battery, push it down into the holder with the positive side to the left as
shown in the drawing above.

4. Replace the computer access panel (Section 6.3, “Access Panel”).
5. Plug in the computer and turn on power.

6. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.
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6.16 Speaker

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

. Move/remove any components necessary to gain access to the speaker.
. Disconnect the speaker wire from the system board connector.

. Remove the four screws @, that secure the speaker to the chassis.

A O B~ W

. Remove the speaker @.

To install the speaker, reverse the removal procedures.
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6.17 Power Supply

WARNING: Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table
to make it easier to work on (Section 6.3, “Access Panel”).

3. Disconnect all power cables from the mass storage devices and from the system board.
4. Remove the screws that connect the power supply to the chassis @.

5. Slide the power supply toward the front of the computer, then lift it out of the computer @.

To install the power supply, reverse the removal procedure.
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Removal and Replacement Procedures—
Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper
service. After completing all necessary removal and replacement procedures, run the Diagnostics
utility to verify that all components operate properly.

Not all features listed in this guide are available on all computers.

Preparation for Disassembly

See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation,” for initial
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 7.2,
“External Security Devices”).

. Close any open software applications.

. Exit the operating system.

B~ W

. Remove any diskette or compact disc from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

During disassembly, label each cable as you remove it, noting its position and routing. Keep all
screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong
screw in an application may damage the unit.
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7.2 External Security Devices

7.2.1 Cable Lock

The cable lock may be used to secure the computer access panel to the chassis and, at the same
time, secure the computer to a fixed object.

As shown, there are two acceptable methods for using the cable lock.While both methods work,
for added security HP recommends that you use the method shown on the left where the cable
lock penetrates both the access panel and the chassis.
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7.2.2 Padlock

A padlock may be used by itself to secure the access panel to the computer chassis. A padlock
may also be used with a security cable to secure the computer to a fixed object.
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7.3 Computer Access Panel

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that
the power cord is disconnected from the electrical outlet.

2. Pull up and hold open the latch on the top of the computer @.
3. Slide the computer access panel @ back about 0.5inch (1.3 cm), then lift it off the unit.

When installing the access panel, press down on its center to ensure the latches are properly
secured while sliding it into the locked position.
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7.4 Front Bezel

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Pull up on the three release tabs @ on the top of the bezel, then pull the front bezel away
from the chassis @.

To reinstall the front bezel, reverse the removal procedure
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7.5 Front Drive Bezels

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).
3. Remove the front bezel (Section 7.4, “Front Bezel”).

4. Press the large retaining tab @ on the left side of the bezel insert to the left and push the
cover out of the front bezel @.

To install a bezel or a bezel blank, reverse the removal procedure.
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7.6 Memory Modules

CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation
resulting from having incompatible metals in contact with each other.

CAUTION: Static electricity can damage the electronic components of the computer or optional cards.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. Refer to Chapter 5, “Identifying the Chassis, Routine Care, and
Disassembly Preparation,” for more information.

CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so
may damage the module.

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components
to cool before touching.

3. Open both latches of the memory module socket @, and insert the memory module into the
socket @. Begin by installing a module into the socket nearest the preinstalled module, and
install the modules following the numerical order of the sockets.

% A memory module can be installed in only one way. Match the notch on the module with the tab
on the memory socket.

4. Push the module down into the socket, ensuring that the module is fully inserted and
properly seated. Make sure the latches are in the closed position ©.

5. Repeat steps 4 and 5 for any additional modules that you want to install.
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% The computer automatically recognizes the additional memory when the computer is turned on.

To reassemble the computer, reverse the removal procedure.

7.7 PCl Expansion Card

. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

. .Disconnect all cables attached to the expansion cards.

W N = =

. If you are installing a card for the first time, go to step 6.
If you are removing an existing card, open the release latch as described in step 6 then go to
step 8.

4. If you are installing an expansion card in a vacant socket, release the expansion card latch @
that secures the PCI slot covers by pulling the latch up.

5. Remove the slot cover by sliding it up and off @.
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6. If you are removing an expansion card from a PCI expansion socket, hold the card at each
end and carefully rock it back and forth until the connectors pull free from the socket. Lift
the expansion card straight up then pull it in toward the center of the chassis to release it
from the chassis frame. Be sure not to scrape the card against other components.
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To install a PCI expansion card:

1. Place the card under the rear panel bracket @, then firmly push the expansion card into the
connector @. Ensure that the card is firmly seated in the expansion card slot.

% Be sure not to touch the rear panel bracket or other components in the chassis when installing an
expansion card.

2. Push the expansion slot latch down @ to secure the card.

If you are not replacing the old expansion card with a new card, install an expansion slot cover to
close the open slot. Insert the metal slot covering the open slot, then push the expansion slot latch
down to secure the slot cover in place.

CAUTION: After removing an expansion card, you must replace it with a new card or cover the open
slot (for example, with a metal slot cover or a piece of cardboard taped in place) for proper cooling of
infernal components. Failure to do so may cause the system to overheat.
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7.8

Drives

The computer supports up to three drives.

This Section describes the procedure for replacing or upgrading the storage drives. A Torx T-15
screwdriver is needed to remove and install the guide screws on a drive.

CAUTION: Make sure personal files on the hard drive are backed up to an external storage device
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard
drive, you will need to run the Restore Plus! CD to load the Compaq factory-installed files.

7.8.1 Drive Positions

Drive Positions

ltem Description ltem Description

(1) One standard 3.5-inch, (3) Internal 3.5-inch, one-third
one-third height bay (1.44-MB height bay for hard drive
diskette drive shown)*.

(2] 5.25-inch drive bay for

optional drives

*If the computer has a 1.44-MB diskette drive installed, it will be configured with a
diskette drive bezel as shown in the illustration. If the computer contains an empty
3.5-inch drive bay, then a bezel blank will be installed on the computer instead. If you
do not have a drive in this slot, you may choose to install a 3.5-inch device (such as a
diskette drive, hard drive, or Zip drive) later on. However, to install a 3.5-inch device
other than a diskette drive or hard drive, you must order the 3.5-inch device bezel to
provide proper air flow within the chassis.

To verify the type and size of the storage device installed in the computer, run Computer Setup.
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7.8.2 Cable Routing

CAUTION: The drive data and power cables must be kept clear of the power supply and the power
supply fan to avoid damage or restrict air flow.

Follow these guidelines when routing the cables in the computer:

1.

Route the optical drive audio cable @ along the back of the optical drive and then down,
alongside of the drive cage to the floor of the chassis. Route this cable behind the hard drive
data cable. Keep the cable clear of the power supply fan.

. Route the optical drive power cable @ down, alongside of the drive cage to the floor of the

chassis. Keep the cable clear of the power supply fan.

. Fold the diskette drive flat-ribbon data cable @ near the connector on the drive. Route the

cable up high on the drive cage (near the cable connectors), then folding again to lay beneath
the optical drive data cable. Be sure the diskette drive cable does not rest on the power
supply and does not interfere with the power supply fan.

. The cable clip @ is attached to the back of the drive cage and secures the diskette drive

power cable. Keep this cable away from the power supply fan.

. The critical area designated @ is the top of the power supply and its fan access area. Keep all

cables away from the top of the power supply to prevent pinching or cutting. Also, keep
cables away from the fan blade area to prevent them from interfering with the fan’s rotation
or reducing the air flow.

360201-002 Service Reference Guide, dc5000



Removal and Replacement Procedures— Small Form Factor (SFF) Chassis

7.8.3 Optical Drive

CAUTION: All removable media should be taken out of the drives before removing the drive from the
computer.

% An optical drive is a CD-ROM, CD-RW, or DVD-ROM drive.

. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
. Remove the computer access panel (Section 7.3, “Computer Access Panel”).
. Remove the front bezel (Section 7.4, “Front Bezel”).

. Raise the Easy Access drive bay to the upright position.
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. Disconnect the audio, signal, and drive power cables from the drive. The other end of the
cables should remain connected to the system board.

. Make sure the drive cables are routed properly (Section 7.8.2, “Cable Routing”).
. Return the Easy Access drive bay to the down position.

. Push the drive release latch @ toward the rear of the chassis and hold.

O 0 3 O

. Slide the drive @ toward the front of the drive cage, then lift the drive out of the computer.
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To replace the drive:

1. Install two guide screws in the lower holes on each side of the drive.

CAUTION: Use only 3/16-inch or 5-mm long screws as guide screws. Longer screws can damage the
internal components of the drive.

% When replacing the drive, transfer the four screws from the old drive to the new one. The screws
take the place of drive rails.

2. Position the guide screws on the drive into the J-slots in the drive bay @. Then, slide the drive
towards the rear of the computer @.

% The drive release latch automatically locks in place when installing a drive.
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3. Raise the Easy Access drive bay to the upright position and connect the flat ribbon cable and
audio cable to the system board.

4. Connect the power cable, flat ribbon cable, and audio cable to the rear of the optical drive.
5. Make sure the drive cables are routed properly (Section 7.8.2, “Cable Routing”).

6. Return the Easy Access drive bay to the down position. Be sure not to pinch the cables in the
chassis when lowering the Easy Access drive bay.

7. Replace the front bezel and computer access panel.

The system automatically recognizes the drive and reconfigures the computer.

CAUTION: When servicing the computer, ensure that cables are placed in their proper locations during
the reassembly process. Improper cable placement can damage the computer.
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7.8.4 External 3.5-inch Drive

. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
. Remove the computer access panel (Section 7.3, “Computer Access Panel”).
. Remove the front bezel (Section 7.4, “Front Bezel”).

. Raise the Easy Access drive bay to the upright position.
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. Disconnect the audio, signal, and drive power cables from the drive. The other end of the
cables should remain connected to the system board.

6. Return the Easy Access drive bay to the down position.
7. Push the drive release latch @ toward the rear of the chassis and hold.

8. Slide the drive @ toward the front of the drive cage, then lift the drive out of the computer.
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% When replacing the drive, transfer the four screws from the old drive to the new one. The screws
take the place of drive rails.

% The guide screws on a 3.5-inch diskette drive @ are placed closer together than on the hard
drive @.

9. Insert the rear screws of the hard drive @ into the rear J-slots. Slide the drive @ toward the
back of the drive cage until the front screws are aligned with the front J-slots. Then lower the
front of the drive. Continue to slide the drive all the way back until it locks into place.

% If replacing a diskette drive, all guide screws (front and rear) will line up on the J-slots. Insert the
guide screws into the J-slots, then slide the drive toward the back of the drive cage until it locks
into place.

10. Connect the power and data cables.
11. Make sure the drive cables are routed properly (Section 7.8.2, “Cable Routing”).
12. Rotate the drive cage to its original position.

13. Replace the front bezel and computer access panel.
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis

7.8.5 Primary Hard Drive

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Remove the front bezel (Section 7.4, “Front Bezel”).

4. Raise the Easy Access drive bay to the upright position.

5. Disconnect the power cable and signal cable from the back of the drive.
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis

6. Press and hold the drive release latch @.
7. Slide the drive to the right of the bay @, then pull the drive from the bay ©.

To replace the hard drive, reverse the above procedure.

% When replacing the hard drive, transfer the four screws from the old drive to the new one. The
screws take the place of drive rails. You will need a Torx T-15 screwdriver to remove and
re-install the guide screws.

Make sure the drive cables are routed properly (Section 7.8.2, “Cable Routing”) before rotating
the drive cage to its original position.
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7.9 Front 1/0 Devices

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Disconnect the two 1/O device cables from the system board: the front USB cable pair and
the front audio cable.

3. Remove the power supply from the chassis (Section 7.16, “Power Supply”).

4. From the inside of the chassis, remove the two screws that secure the I/0O device to the
chassis @, then pull the device into the chassis @ to free it from its mount.

s

To install the housing assembly, reverse the removal procedures.
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis

7.10 Power Switch Assembly

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
2. Disconnect the power switch/LED cable from the system board.

3. Carefully cut the cable tie that secures the power switch cable to the power supply cable
cable bundle.

fi CAUTION: Be careful when cutting the cable tie not to cut any cables.

4. Squeeze the switch holder retaining clips together at the front of the chassis @ and push the
switch assembly out of the chassis @.

To install the power switch assembly, reverse the removal procedure.
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7.11 System Board

. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

. Remove all PCI expansion boards (Section 7.7, “PCI Expansion Card”).

. Remove the AGP graphics card (Section 7.7, “PCI Expansion Card”).

. Disconnect all cables connected to the system board, noting their location for reinstallation.

AN B W N =

. Compress the system board tray handle @ to release the latch and slide the system board tray
towards the front of the computer @ to free it from the back of the chassis.

To install the system board, slide the tray assembly into the chassis and press down on the two
places shown in the drawing @ while sliding the tray into its locked position @.
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7.12 Chassis Fan

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Remove the system board (Section 7.11, “System Board”).
4.

Remove the chassis fan cable from the wiring harness and from cable clip @ near the front of
the chassis.

5. Remove the screws or the two-piece plastic push-pins that secure the fan to the chassis @
then, slide the fan up and out of the chassis ©.

To install the chassis fan, reverse the removal procedure. If the fan is installed with screws, spin
the fan blades to ensure they are not making contact with the fan housing. If the fan is installed
with plastic push-pins, use the new pins provided in the fan kit.

CAUTION: Do not overtighten the two mounting screws. Overtightening the screws may deform the fan
housing and result in a “clicking” noise when the fan is running.
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713
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Battery

The battery that comes with this computer provides power to the real-time clock and has a
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and
burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.
Do not expose to temperatures higher than 140°F (60°C)

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or
water.

Replace the battery only with the HP/Compagq spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Troubleshooting
Guide for information on backing up the CMOS settings.

Batteries, battery packs, and accumulators should not be disposed of together with the general
household waste. In order to forward them to recycling or proper disposal, please use the public
collection system or return them to HP/Compagq, their authorized pariners, or their agents.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Carefully pull the cable bundle out of the way to access the battery.

5. Depending on the type of battery holder on your system board, complete the following

instructions to replace the battery:
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis

7.13.1 Type 1 Battery Holder

1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.
4. Replace the computer cover or access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.
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7.13.2 Type 2 Battery Holder

1. To release the battery from its holder, squeeze the metal clamp that extends above one edge
of the battery @. When the battery pops up, lift it out.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip &
with the positive side up. Push the other edge down until the clamp snaps over the other edge
of the battery.

% After the battery has been replaced, use the following steps to complete this procedure.

3. Replace the computer cover or access panel.
4. Plug in the computer and turn on power to the computer.

Reset the date and time, your passwords, and any special system setups, using Computer Setup.
Refer to the Computer Setup (F10) Utility Guide.
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7.14 Processor and Heatsink

. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

. Lift up the lever that secure the fan to the heatsink @ and rotate the fan up @.

AW N =

. Release the two latch locks ® and raise the legs that secure the latches to the base of heatsink
mount @.

9

. Tap the heatsink to check its temperature. If it is cool enough to handle, then proceed.

6. Twist the heatsink slightly to break the bond between it and the processor, the lift the
heatsink from the processor ©.

7. Rotate the ZIF socket handle to its fully open position @ and remove the processor from the
socket @.

To install the processor and heatsink:
1. Insert the processor into the ZIF socket.
. Press down on the processor while rotating and locking the ZIF socket handle in place.
. Refresh the thermal grease between the heatsink and processor if necessary.

2

3

4. Install the heatsink and latch it in place.

5. Connect the heatsink fan control to the system board.
6

. Replace the access panel and reconnect the computer.

Service Reference Guide, dc5000 360201-002 7-27



Removal and Replacement Procedures— Small Form Factor (SFF) Chassis

7.15 Speaker

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Rotate the drive cage to its upright position.

4. Disconnect the speaker wire from the system board.

5. Carefully cut the cable tie that secures the speaker cable to the power supply cable bundle.

fi CAUTION: Be careful when cutting the cable tie not to cut any cables.

6. Remove the power supply from the chassis (Section 7.16, “Power Supply”).
7. Remove the two screws that secure the speaker to the chassis @.

8. Slide the speaker towards the rear of the chassis and down to remove it @.

To install the speaker, reverse the removal procedures.
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7.16 Power Supply

WARNING: Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should
be disconnected from the computer and/or the AC outlet before opening the computer.

. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).
. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

. Rotate the drive cage to its upright position.

AW N =

. Carefully cut the cable tie that secures the power supply cable bundle to the power switch
cable, the speaker cable, and the front I/O cable.

91

. Disconnect all power cables from the mass storage devices and from the system board.

6. Remove the three screws that secure the rear chassis panel to the chassis @, the pull the rear
chassis panel straight back @ to remove it from the chassis.

7. Slide the power supply out the back of the computer ©.
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When installing the power supply, reverse the removal procedure, making sure that the clips on
the bottom of the rear panel fit in the slots provided.
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Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors.
Some of these connectors may not be used on the product being serviced.

Enhanced Keyboard

Connector and lcon Pin Signal
1 Data
e 2 Unused
ooooooo 3 GrOUnd
oc——ao
4 +5 VDC
5 Clock
6 Unused
Mouse
Connector and Icon Pin Signal
1 Data
2 Unused
El? g% &1 3 Ground
B0 4 +5 VDC
5 Clock
6 Unused
Ethernet BNC
Connector and lcon Pin Signal

1 (Center) Data

._.. .Eu_ﬂ@, 2 (Shield) Ground
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Connector Pin Assignments

Ethernet RJ-45

Connector and Icon Pin Signal
1 (+) Transmit Data
2 () Transmit Data
’:' O = 3 (+) Receive Data
4 Unused
5 Unused
6 () Receive Data
7 Unused
8 Unused
Ethernet AUI
Connector and Icon
loJoJoJoJoloJolo) EIRE
® @O
Pin Signal Pin Signal
1 Ground 9 Positive AUI Differential Receive
2 Negative AUI Differential Collision 10 +12V
3 Positive AUI Differential Collision 11 Ground
4 Negative AUl Differential Transmit 12 Ground
5 Positive AUI Differential Transmit 13 Unused
6 Ground 14 Unused
7 Ground 15  Unused
8 Negative AUl Differential Receive 16 Unused
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Connector Pin Assignments

Parallel Interface

Connector and Icon

\@@@@@@@@@oo/ m

(clolelelololololololo)o)] [—\0
Pin Signal Pin Signal Pin Signal
1 Strobe 7 Data Bit 5 13 Select
2 Data Bit O 8 Data Bit 6 14 Auto Linefeed
3 Data Bit 1 9 Data Bit 7 15 Error
4 Data Bit 2 10 Acknowledge 16 Initialize Printer
5 Data Bit 3 11 Busy 17 Select IN
6 Data Bit 4 12 Paper End 1825 Signal Ground

Serial Interface, Powered and Non-Powered
Connector and lcon Pin Signal

1 Carrier Detect (12V if powered)
2 Receive Data
COOOO6 3 Transmit Data
0J0)
4 Data Terminal Ready
5 Signal Ground
6 Data Set Ready
7 Request to Send
8 Clear to Send
9 Ring Indicator (5V if powered)
USB
Connector and Icon Pin Signal
1 +5 VDC
2 - Data
4 Ground
Microphone
Connector and Icon (1/8" miniphone) Pin Signal

Tip) Audio

1
ﬁéﬂ:ﬂ: @ giRing) Power

Shield)  Ground
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Connector Pin Assignments

Headphone
Connector and Icon (1/8" miniphone) Pin Signal
1 (Tip) Audio_Left
123
@: @ ) 2 (Ring) Audio_Right
3 (Shield)  Ground
Line-In Audio
Connector and Icon (1/8" miniphone) Pin Signal
1 (Tip) Audio_In_Left
123 _ _ ,
@: $<: 2 (Ring) Audio_In_Right
3 (Shield)  Ground
Line-Out Audio
Connector and Icon (1/8" miniphone) Pin Signal
1 (Tip) Audio_Out_Left
J&é&sﬂ:ﬂ: J:> 2 (Ring) Audio_Out_Right
3 (Shield)  Ground

SCSI Low Voltage Differential/Single Ended (LVD/SE)

Connector and lcon

0 o L& 3

Pin Signal Pin Signal Pin Signal Pin Signal
1-16 Ground 40 DO 49-50 Ground 60 -MSG
17-18 TERMPWR 41 D1 51-52 TERMPW 61 -SEL
19 Reserved 42 DI 53 Reserved 62 -C/D
20-34  Ground 43 D3 54 Ground 63 -REQ
35 D12 44 D4 55 -ATN 64 1/0
36 D13 45 D5 56 Ground 65 -D
37 D14 46 D6 57 -BSY 66 -D
38 -D15 47 D7 58 -ACK 67 -D
39 -DP1 48 -DPO 59 -RST 68 -D
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Connector Pin Assignments

Ultra SCSI
Connector and Icon
It I <o
Pin Signal Pin Signal Pin Signal Pin Signal
1-11 Ground 29 DB3 37 Reserved 45 RST #
12 Reserved 30 DB4 38 TERMPWR 46 MSG #
13 Open 31 DB5 39 Reserved 47 SEL #
14 Reserved 32 DB6 40 Ground 48 C/D
15-25 Ground 33 DB7 41 ATN # 49 REQ #
26 DBO 34 DBP 42 Ground 50  Input/Output
27 DB1 35 Ground 43 BSY #
28 DB2 36 Ground 44 ACK #
External Infrared Transceiver
Connector and Icon
ofa[o] > i,
DED ==\
[Bafo] &
Pin Signal Pin Signal Pin Signal
1 Transmit 4 5V 7 Not Used
2 Receive 5 Mode 8 Not Used
3 Ground 6 Not Used
Monitor
Connector and Icon
(oJoJoJo]o) @
@000
PEEEO
Pin  Signal Pin  Signal Pin  Signal
1 Red Analog 6 Ground 11 Not used
2 Green Analog 7 Ground 12 DDC Serial Data
3 Blue Analog 8 Ground 13 Horizontal Sync
4 Not used 9 +5V (fused) 14 Vertical Sync
5 Ground 10 Ground 15 DDC Serial Clock

Service Reference Guide, dc5000

360201-002

A-5



Connector Pin Assignments

ATA/ATAPI (IDE) Standard Drive Cable

Connector

39

1

40

2

Pin Signal Pin Signal Pin Signal
1 Reset 15 DD1 29 DMAK
2 Ground 16 DD14 30 Ground
3 DD7 17 DDO 31 INTRQ
4 DD8 18 DD15 32 IOCS16
5 DD6 19 Ground 33 DA1
6 DD9 20 (Key) 34 PDIAG (cable detect)
7 DD5 21 DMARQ 35 DAO
8 DD10 22 Ground 36 DA2
9 DD4 23 DIOW 37 CSTFX
10 DD11 24 Ground 38 CS3FX
11 DD3 25 DIOR 39 DASP
12 DD12 26 Ground 40 Ground
13 DD2 27 IORDY
14 DD13 28 CSEL
20-Pin Power
Connector
20 11
FWEEEWEEEE)
gnnoonnoon
10 1
Pin Signal Pin Signal Pin Signal Pin Signal
1 +3.3V 6 +5V 11T +33V 16 GND
2 +3.3V 7 GND 12 12V 17  GND
3 GND 8 POK 13 GND 18  open*
4 +5V 9 +5 Vaux 14  PSON 19  +5V
5 GND 10 +12V 15 GND 20 45V
*Open for d300 series computers; -5V for all others
4-Pin Power (for CPU)
Connector and lcon Pin Signal
. 1 GND
|
2 GND
0:10(0):0
=] 3 +12V
2 1 4 -12V
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Power Cord Set Requirements

The voltage select switch feature on the computer permits it to operate from any line voltage
between 100-120 or 220-240 volts AC.

The power cord set received with the computer meets the requirements for use in the country
where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you
use the computer. For more information on power cord set requirements, contact your authorized
HP dealer, reseller, or service provider.

General Requirements

The requirements listed below are applicable to all countries:

1. The length of the power cord set must be at least 6.00 feet (1.8 m) and a maximum of 9.75
feet (3.0 m).

2. All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be used.

3. The power cord set must have a minimum current capacity of 10A and a nominal voltage
rating of 125 or 250 volts AC, as required by each country’s power system.

4. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector, for mating with appliance inlet on the Switch Box.
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Power Cord Set Requirements Power Cord Set Requirements

Country-Specific Requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Accrediting Accrediting

Country Agency Country Agency
Australia (1) EANSW ltaly (1) IMQ
Austria (1) OVE Japan (3) METI
Belgium (1) CEBC Norway (1) NEMKO
Canada (2) CSA Sweden (1) SEMKO
Denmark (1) DEMKO Switzerland (1) SEV
Finland (1) SETI United Kingdom (1) BSI
France (1) UTE United States (2) uL
Germany (1) VDE

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm? conductor size.
Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of
the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SIT or equivalent, No. 18 AWG, 3-conductor. The wall plug
must be a two-pole grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P
(15A 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a "T" mark and registration
number in accordance with the Japanese Dentori Law. Flexible cord must be Type VCT or
VCTF, 3-conductor, 1.0 mm? conductor size. Wall plug must be a two-pole grounding type
with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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POST Error Messages

An error message results if the Power-On Self-Test (POST) encounters a problem. This test runs
when the system is turned on, checking assemblies within the computer and reporting any errors

found.

Not all computers use all of the codes listed.

POST Error Messages

Screen Message

Probable Cause

Recommended Action

101-Option ROM Error

System ROM checksum.

Verify the correct ROM.
Flash the ROM if needed.

If an expansion card was recently
added, remove it and see if the problem
remains.

Clear CMOS.

If the message disappears, there may be
a problem with the expansion card.

Replace the system board.

102-System Board
Failure

DMA, timers, etc.

Clear CMOS.
Remove expansion boards.
Replace the system board.

103-System Board

DMA, timers, etc.

Clear CMOS.

Failure Remove expansion boards.
Replace the system board.
150-SafePost Active A PCl expansion card is  Restart the computer.

not responding.

Disable SafePost.

If the expansion card does not respond,
replace the card.

162-System Options
Not Set

Configuration incorrect.
RTC (real-time clock)
battery may need to be
replaced.

Run Computer Setup (F10 Setup).

Set the date and time under Control
Panel or in F10 Setup depending on
the operating system.

If the problem persists, replace the RTC
battery.
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POST Error Messages

POST Error Messages

Screen Message

Probable Cause

Recommended Action

163-Time & Date Not
Set

Invalid time or date in
configuration memory.

RTC (realtime clock)
battery may need to be
replaced.

CMOS jumper may not
be properly installed.

Set the date and time under Control
Panel or in F10 Setup depending on
the operating system.

If the problem persists, replace the RTC
battery.

164-Memory Size Error

Memory configuration is
incorrect.

Run Computer Setup (F10 Setup) or
Windows utilities.

Make sure memory module(s) (if any) are
installed properly.

If third party memory has been added,
test using HP-only memory.

Verity proper memory module type.

183-Invalid Processor
Jumper Setting

System board jumper
improperly set.

Reset system board jumpers to match
processor and bus speeds (select
models).

201-Memory Error

RAM failure.

Run Computer Setup (F10 Setup) or
Windows utilities.

Ensure memory and continuity modules
are installed correctly.

Verity proper memory module type.

Remove and replace memory module(s)
one at a time fo isolate faulty module.

Replace the faulty memory module(s).

If error persists after replacing memory
modules, replace the system board.

202-Memory Type Memory modules do not  Replace memory modules with matched
Mismatch match each other. sefs.
207-ECC Corrected Single Bit ECC error. Verity proper memory module type.

Single Bit Errors in
Memory Socket(s) y,y

Try another memory socket.

Replace memory module if problem
persists.

212-Failed Processor

Processor has failed to
initialize.

Reseat the processor in its socket.

If the processor does not respond,
replace it.

213-Incompatible
memory Module in
memory Sockef(s)
XX, X

A memory module in
memory socket identified
in the error message is
missing critical SPD
information, or is
incompatible with the
chipset.

Verify proper memory module type.
Try another memory socket.

Replace memory with a module
conforming to the SPD standard.

c-2
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POST Error Messages

Screen Message

Probable Cause

Recommended Action

214-DIMM
Configuration Warning

Populated DIMM
Configuration is
unbalanced.

2 DIMMS - For maximum performance,
place both DIMMs in the two BLACK
DIMM slots.

4 DIMMS - For maximum performance,
swap one DIMM in a BLUE slot with one
in a BLACK slot.

301-Keyboard Error

Keyboard failure.

Reconnect keyboard with computer
turned off.

Check connector for bent or missing
pins.

Ensure that none of the keys are
depressed.

Replace keyboard.

303-Keyboard
Controller Error

I/O board keyboard

controller.

Reconnect keyboard with computer
turned off.

Replace the system board.

304-Keyboard or
System Unit Error

Keyboard failure.

Reconnect the keyboard with computer
turned off.

Ensure that none of the keys are
depressed.

Replace keyboard.
Replace system board.

401-Parallel Port 1

IRQ address conflicts with

Reset the IRQ.

Address Assignment another device.

Conflict

402-Parallel Port 2 IRQ address conflicts with  Reset the IRQ.
Address Assignment another device.

Conflict

403-Parallel Port 3 IRQ address conflicts with  Reset the IRQ.
Address Assignment another device.

Conflict

404-Parallel Port
Address Conflict
Detected

Both external and internal
ports are assigned to
parallel port X.

Remove any parallel expansion cards.
Clear CMOS.

Reconfigure card resources and/or run
Computer Setup (F10 Setup).

410-Audio Interrupt
Conflict

IRQ address conflicts with
another device.

Reset the IRQ.

411-Network Interface
Card Interrupt Conflict

IRQ address conflicts with
another device.

Reset the IRQ.

417-Network Interface
card Failure

Failure to read MAC
address information from

NIC.

Unplug AC power cord, wait 5 seconds,
then reboot unit.

Service Reference Guide, dc5000
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POST Error Messages

Screen Message

Probable Cause

Recommended Action

501-Display Adapter
Failure

Graphics display
controller.

Reseat the graphics card (if applicable).
Clear CMOS.

Verify that the monitor is attached and
turned on.

Replace the graphics controller.

510-Splash Screen

image corrupted

Splash Screen image has
errors.

Install latest version of ROMPagq to
restore image.

511-CPU, CPUA, or
CPUB Fan not detected

Fan is not connected or
may have malfunctioned.

Reseat fan cable.
Reseat the fan.

Replace the fan.

512-Chassis, rear
chassis, or front chassis
fan not detected

Fan is not connected,
may have malfunctioned.

Reseat chassis, rear chassis, or front
chassis fan cable.

Reseat chassis, rear chassis, or front
chassis fan.

Replace chassis, rear chassis, or front
chassis fan.

514-CPU or Chassis

Fan not detected.

CPU fan is not connected
or may have
malfunctioned.

Reseat CPU or chassis fan.
Replace CPU or chassis fan.

520-Single Monitor

Configuration warning

Single monitor
configuration with
monitor attached to video
port 2.

Turn off unit, attach monitor to video port
1, then restart unit.

601 -Diskette Controller

Error

Diskette controller
circuitry or floppy drive
circuitry incorrect.

Run Computer Setup (F10 Setup).
Check and/or replace cables.
Clear CMOS.

Replace diskette drive.

Replace the system board.

602-Diskette Boot

Record Error

Diskette in drive A not
bootable.

Replace the diskette.

605-Diskette Drive Type

Error

Mismatch in drive type.

Run Computer Setup (F10 Setup).

Disconnect any other diskette controller
devices (tape drives).

Clear CMOS.

610-External Storage
Device Failure

External tape drive not
connected.

Reinstall tape drive or press F1 and
allow system to reconfigure without the
drive.

611-Primary Floppy Port
Address Assignment
Conflict

Configuration error.

Run Computer Setup (F10 Setup).
Remove expansion cards.

Clear CMOS.

C4
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POST Error Messages

Screen Message

Probable Cause

Recommended Action

660-Display Cache is
Detected Unreliable

Integrated video
controller display cache
not working properly and

will be disabled.

Replace system board if minimal video
degrading is an issue.

912-Computer Cover
Has Been Removed
Since Last System Start
Up

No action required.

914-Hood Lock Coil is
not Connected

Smart Cover lock
mechanism is missing or
not connected.

Reconnect or replace hood locking
mechanism.

Reseat or replace hood locking
mechanism cable.

917-Expansion Riser
not Detected

Riser board not seated or
not installed.

Install riser board if missing or remove
and reseat fo ensure good connection.

919-Front Panel and/or
MultiPort Risers not
Detected.

Riser card has been
removed or has not been
reinstalled properly in the
system.

Unplug computer and install/reinstall
riser cord.

1151-Serial Port 1
Address Conflict
Detected

Both external and internal
serial ports are assigned

to COM1.

Remove any Comm port expansion
cards.

Clear CMOS.

Reconfigure card resources and/or run
Computer Setup (F10 Setup). Run

Computer Setup or Windows utilities.

1152-Serial Port 2
Address Conflict
Detected

Both external and internal
serial ports are assigned

to COM2.

Remove any Comm port expansion
cards.

Clear CMOS.

Reconfigure card resources and/or run
Computer Setup (F10 Setup). Run

Computer Setup or Windows utilities.

1155-Serial Port
Address Conflict
Detected

Both external and internal
serial ports are assigned
to same IRQ.

Remove any Comm port expansion
cards.

Clear CMOS.

Reconfigure card resources and/or run
Computer Setup (F10 Setup).Run

Computer Setup or Windows utilities.

1156-Serial Port A
Cable Not Detected

Serial Port cable
assembly disconnected
from system board.

Turn off unit, disconnect the power cable
from the power source, open the
computer chassis and attach serial port
cable to the system board.

1157-Front Cables Not
Detected

Front cable assembly
(audio and USB)
disconnected from the
system board.

Turn off unit, disconnect the power cable
from the power source, open the
computer chassis and attach front cable
assembly to the system board.
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POST Error Messages

POST Error Messages

Screen Message

Probable Cause

Recommended Action

1201-System Audio
Address Conflict
Detected

Device IRQ address
conflicts with another
device.

Reset the IRQ.

1202-MIDI Port Address
Conflict Detected

Device IRQ address
conflicts with another
device.

Reset the IRQ.

1203-Game Port
Address Conflict
Detected

Device IRQ address
conflicts with another
device.

Reset the IRQ

1720 SMART Hard
Drive Detect Imminent
Failure

Hard drive is about to
fail. (Some hard drives
have a firmware patch
that will fix an erroneous
error message.)

Determine if hard drive is giving correct
error message. Run the Drive Protection
System text if applicable.

Apply firmware patch if applicable. (see
www.hp.com/support)

Back up contents and replace hard drive.

1800-Temperature Alert

Internal temperature
exceeds specification.

Check that computer air vents are not
blocked and cooling fan is running.

Verify processor speed selection.
Replace the processor.

Replace the system board.

1801-Microcode Patch

Error

Processor not supported

by ROM BIOS.

Upgrade BIOS to proper version.

1998-Master Boot

Record has been lost.

The previously saved
copy of the MBR has

been corrupted.

Run Computer Setup and save the MBR
of the current bootable disk.

1998-Master Boot
Record has been
changed.

The current MBR does not
match the previously

saved copy of the MBR.

Use extreme caution, The MBR may have
been updated due to normal disk
maintenance activities (disk manager,
fdisk, or format). Replacing the
previously saved MBR in such situations
can cause data loss. If certain that the
MBR change is unintentional and
undesired (e.g. due fo a virus), run
Computer Setup and restore the
previously saved MBR copy. Otherwise,
run Computer Setup and either disable
MBR security or save the MBR of the
current bootable disk.

2000-Master Boot
Record Hard Drive has
Changed.

The current bootable hard
drive is not the same as
the one that was present
when MBR security was

enabled.

Run Computer Setup and either disable
MBR security or save the MBR of the
current bootable disk.
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POST Error Messages

POST Error Messages

Screen Message

Probable Cause

Recommended Action

Invalid Electronic Serial

Number.

Electronic serial number
has become corrupted.

Run Computer Setup. If Setup already
has data in the field or will not allow the
serial number to be entered, download
from http://www.hp.com and run
SP5572.EXE (SNZERO.EXE).

Run Computer Setup and try to enter
serial number under Security, System ID,
then save changes.

ECC Multiple Bit Error
Detected in Memory
Module.

Chipset has detected
more than one bad bit in
a 64-bit quadword of the
memory array.

Replace the memory module.

Parity Check 2.

Parity RAM failure.

Run Computer Setup and Diagnostic
utilities.
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Troubleshooting Without Diagnostics

Preliminary Checklist

This section describes some simple, preliminary tests and guidelines for troubleshooting the
computer without using the diagnostics.

Are the computer and monitor connected to a working electrical outlet?

Is the voltage select switch is set to the appropriate voltage for your region (115V or 230V)?
Is the computer turned on?

Is the green power light illuminated?

Is the monitor turned on?

Is the green monitor light illuminated?

Turn up the monitor brightness and contrast controls if the monitor is dim.

If the system has multiple video sources (embedded or PCI adapters) installed and a single
monitor, the monitor must be plugged into the monitor connector on the source selected as
the primary VGA adapter. During boot, the other monitor connectors are disabled and if the
monitor is connected into these ports, the monitor will not function. You can select which
source will be the default VGA source in Computer (F10) Setup.

Press and hold any key. If the system beeps, then the keyboard is operating correctly.
Check all cables for loose or incorrect connections.

Reconfigure the computer after installing a non—Plug and Play expansion board or other
option, such as a diskette drive.

Are all of the necessary device drivers installed?

Have all printer drivers been installed for each application?

Remove all diskettes from the diskette drives before you turn on the system.
Are all switches set correctly?

Is the NIC Remote Wakeup cable (featured on some models) connected between the NIC
and the riser/system board?
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Troubleshooting Without Diagnostics

Solving Minor Problems

Solving Minor Problems

Problem Cause Possible Solution

Computer appears Software control of the 1. Press and hold the power button

locked up and will not  power switch is not for at least four seconds until the

turn off when the power  functional. computer turns off.

button is pressed. 2. Disconnect electrical plug from
outlet.

Computer will not Computer is in Press the power button to resume from

respond to USB standby mode. standby mode.

keyboard or mouse.

A CAUTION: When attempting to resume from standby mode, do not hold down the power
button for more than four seconds. Otherwise, the computer will shut down and you will lose

your data.
Computer date and RTC (real-time clock) 1. Reset the date and time under
time display is incorrect.  battery may need to be Control Panel.
replaced. 2. Replace the RTC battery.
Computer appears to Network driver is loaded  Establish a network connection, or
pause periodically. and no network use Computer Setup or Microsoft
connection is established.  Windows Device Manager to disable
the network controller.
Cursor will not move The Num Lock key Press the Num Lock key. The Num
using the arrow keys on  may be on. Lock key can be disabled (or
the keypad. enabled) in Computer Setup.
Poor performance is Processor is hot. 1. Ensure airflow to the computer is
experienced. not blocked.

2. Ensure the fans are connected
and working properly (some fans
only operate when needed).

3. Ensure the processor heatsink is
installed properly.

Hard drive is full. Transfer data from the hard drive to
create more space on the hard drive.
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Troubleshooting Without Diagnostics

Solving Minor Problems (Continued)

Problem

Cause

Possible Solution

Computer powered off
automatically and the

Power LED flashes Red
two times, once every

second, followed by a
two second pause.

Processor thermal
protection activated:

A fan may be blocked or
not turning.

OR

The heatsink is not

properly attached to the
processor.

1.

Ensure computer air vents are not
blocked and the cooling fan is
running.

. Open hood, press power button,

and see if the processor fan
spins. If not spinning, make sure
the fan's cable is plugged onto
the system board header. Ensure
the fan is fully/properly seated or
installed.

. Replace the processor fan.
. Reseat processor heatsink and

verify that the fan assembly is
properly attached.

System does not power
on and the LEDs on the
front of the computer
are not flashing.

System unable to power
on.

Press and hold the power button for
less than 4 seconds. If the hard drive
LED turns green, then:

1.

3.
OR

Check that the voltage selector is
set to the appropriate voltage.

. Remove the expansion cards one

at a time until the 3.3 V_aux light
on the system board turns on.

Replace the system board.

Press and hold the power button for
less than 4 seconds. If the hard drive
LED does not turn on green then:

1

. Check that the unit is plugged

into a working AC outlet.

. Open hood and check that the

power button harness is properly
connected to the system board.

. Check that both power supply

cables are properly connected to
the system board.

. If the 3.3 V_aux light on the

system board is on, then replace
the power button harness.

. If the 3.3 V_aux light on the

system board is off, then replace
the power supply.

. Replace the system board.
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Troubleshooting Without Diagnostics

Solving Power Supply Problems

Solving Power Supply Problems

Problem

Cause

Solution

Power supply shuts down
intermittently.

Voltage selector switch
on rear of computer
chassis not switched to
correct line voltage.

Select the proper AC voltage.

Power supply fault.

Replace the power supply.

Computer powered off
automatically and the
Power LED flashes Red two
times, once every second,
followed by a two second
pause.

Processor thermal
protection activated:
A fan may be blocked

or not turning.
OR
The heatsink/fan

assembly is not properly
attached to the
processor.

1

. Ensure that the computer air

vents are not blocked and the
cooling fan is running.

. Open hood, press the power

button, and see if the processor
fan spins. If the processor fan is
not spinning, make sure the
fan's cable is plugged onto the
system board header. Ensure
the fan is fully/properly seated
or installed.

. Replace the processor fan.

. Reseat processor heatsink and

verify that the fan assembly is
properly attached.

Power LED flashes Red,
once every two seconds.

Power failure (power
supply is overloaded).

J—

. Check that the voltage selector,

is set fo the appropriate voltage.

. Open the hood and ensure the

4-wire power supply cable is
seated into the connector on the
system board.

. Check it a device is causing the

problem by removing ALL
attached devices). Power on the
system. If the system enters the
POST, then power off and
replace one device at a time
and repeat this procedure until
failure occurs. Replace the
device causing the failure.
Continue adding devices one at
a time to ensure all devices are
functioning properly.

. Replace the power supply.
. Replace the system board.
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Troubleshooting Without Diagnostics

Solving Diskette Problems

Solving Diskette Problems

Problem

Cause

Solution

Diskette drive light stays on.

Diskette is damaged.

In Microsoft Windows XP, right-click
Start, click Explore, and select a
drive. Select File > Properties >
Tools. Under Error-checking,
click Check Now.

Diskette is incorrectly
inserted.

Remove diskette and reinsert.

Drive button is not
pushed in.

Push in drive button.

Files on diskette are
damaged.

Check the program diskettes.

Drive cable is not
properly connected.

Reconnect power cable. Ensure that
all four pins are connected.

Drive not found.

Cable is loose.

Reseat diskette drive data and
power cables.

Removable drive is not
seated properly.

Reseat the drive.

Diskette drive cannot write
to a diskette.

Diskette is not
formatted.

Format the diskette.

Diskette is
write-protected.

Use another diskette or remove the
write protection.

Writing to the wrong
drive.

Check the drive letter in the path
statement.

Not enough space is
left on the diskette.

Use another diskette.

Diskette write control is

enabled.

Use Computer Setup to check the
storage security feature disabled
settings.

Diskette is damaged.

Replace the damaged disk.

Cannot format diskette.

Invalid media reported.

When formatting a disk in MS-DOS,
you may need to specify diskette
capacity. For example, to format a
1.44-MB diskette, type the following
command at the MS-DOS prompt:

FORMAT A: /F:1440

A problem has occurred
with a disk transaction.

The directory structure is
bad, or there is a
problem with a file.

In Windows XP, right-click Start,
click Explore, and select a drive.
Select File > Properties >
Tools. Under Error-checking,
click Check Now.
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Troubleshooting Without Diagnostics

Solving Diskette Problems (Continued)

Problem Cause Solution
Diskette drive cannot read Diskette is not Format the diskette.
a diskette. formatted.

You are using the wrong
diskette type for the
drive type.

Check the type of drive that you
are using and use the correct
diskette type.

You are reading the
wrong drive.

Check the drive letter in the path
statement.

Diskette is damaged.

Replace the diskette with a new one.

“Invalid system disk”
message is displayed.

A diskette that does not
contain the system files
needed to start the
computer has been
inserted in the drive.

When drive activity stops, remove
the diskette and press the
Spacebar. The computer should
start up.

Diskette error has
occurred.

Restart the computer by pressing the
power button.

Cannot Boot to Diskette.

Diskette is not bootable.

Replace with a bootable diskette.

Diskette boot has been
disabled in Computer
Setup.

Run Computer Setup and enable
diskette boot in Storage > Boot
Order.

Removable media boot
has been disabled in
Computer Setup.

Run Computer Setup and enable
Removable Media Boot in
Storage > Storage Options.

Diskette MBR validation
is enabled.

Run Computer Setup and disable
Diskette MBR Validation in
Storage > Storage Options.

Solving Hard Drive Problems

Solving Hard Drive Problems

Problem

Cause

Solution

Hard drive error occurs.

Hard disk has bad

sectors or has failed.

Use a utility to locate and block
usage of bad sectors. If necessary,
reformat the hard disk.

Disk transaction problem.

Either the directory
structure is bad or there
is a problem with a file.

In Windows XP, right-click Start,
click Explore, and select a drive.
Select File > Properties > Tools.
Under Error-checking, click
Check Now.

Drive not found (identified).

Loose cable.

Check cable connections.
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Troubleshooting Without Diagnostics

Solving Hard Drive Problems (Continued)

Problem

Cause

Solution

The system may not
have automatically
recognized a newly
installed device.

1. Run Computer Setup.

2. If the system still does not
recognize the new device,
check to see if the device is
listed within Computer Setup. If
it is listed, the probable cause is
a driver problem. If it is not
listed, the probable cause is a
hardware problem.

3. If this is a newly installed drive,
enter Setup and try adding a
POST delay under Advanced
> Power-On.

Drive jumper settings
may be incorrect.

If the drive is a secondary drive that
has just been installed on the same
cable as the primary drive, verify
that the jumpers for both drives are
set correctly.

Drive’s IDE (ATA)
controller is disabled in
Computer Setup.

Run Computer Setup and enable the
Primary and Secondary IDE (ATA)
controllers in Storage > Storage
Options.

Drive responds slowly
immediately after
power-up.

Run Computer Setup and increase
the POST Delay in Advanced >
Power-On Options.

Nonsystem disk/NTLDR
missing message.

System is trying fo start
from a non bootable
diskette.

Remove the diskette from the diskette
drive.

Nonsystem disk/NTLDR
missing message.
(continued)

System is trying fo start
from a damaged hard
drive.

1. Insert a bootable diskette into
the diskette drive and restart the
computer.

2. If the hard drive is still
inaccessible and MBR Security
is enabled, try restoring the
previously saved MBR image by
entering Setup and selecting
Security > Restore Master
Boot Record.

System files missing or
not properly installed.

1. Insert a bootable system diskette
and restart.

2. Verify hard drive is partitioned
and formatted.

3. Install system files for the
appropriate operating system if
necessary.
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Troubleshooting Without Diagnostics

Solving Hard Drive Problems (Continued)

Problem

Cause

Solution

Hard drive boot
disabled in Computer
Setup.

Run Computer Setup and enable the
hard drive entry in the Storage >
Boot Order list.

Second Ultra ATA hard
drive does not perform
optimally.

Using the wrong cable
for the drive type.

Reinstall the second Ultra ATA hard
drive using an 80-conductor cable
(standard on select models.)

Both slow and fast
UATA devices are on
the same data cable.

Connect slower UATA devices to a
separate data cable connected to
the secondary IDE (ATA) controller.

Computer will not start.

Hard drive is damaged.

Observe the beeps and LED lights
on the front of the computer. See
Appendix C, “POST Error
Messages.”

Computer seems to be
locked up.

Program in use has
stopped responding to
commands.

1. Attempt the normal Windows
“Shut Down” procedure.

2. Press the power button for
four or more seconds to turn off
the power.

3. Restart the computer using the
power button.
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Troubleshooting Without Diagnostics

Solving Display Problems

Solving Display Problems

Problem

Cause

Solution

Blank screen (no video).

The cable connections
are not correct.

Check the cable connections from
the monitor to the computer and to
the electrical outlet.

Screen blanking utility
installed or energy

saver features enabled.

Press any key or click the mouse
button and, if set, type your
password.

System ROM is bad;
system is running in

FailSafe Boot Block

mode (indicated by

eight beeps).

Reflash the ROM using a ROMPaq
diskette.

Fixed-sync monitor will
not sync at the
resolution chosen.

Ensure that the monitor can accept
the same horizontal scan rate as the
resolution chosen.

Computer is in
standby mode.

Press the power button to resume
from standby mode.

CAUTION: When attempting fo resume from standby mode, do not hold down the
power button for more than four seconds. Otherwise, the computer will shut down
and you will lose your data.

Monitor cable plugged
info the wrong
connector.

If the computer system has both
an integrated graphics connector
and a PCl expansion card
connector, plug the monitor cable
into the PCI card connector.

Monitor settings in the
computer are not
compatible with the
monitor.

1. Restart the computer and press
F8 during startup when you see
“Press F8" in the bottom right
corner of the screen.

2. Using the keyboard arrow keys,
select Enable VGA Mode
and press Enter.

3. In Windows Control Panel,
double-click the Display icon
and select the Settings tab.

4. Use the sliding control to reset
the resolution.
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Troubleshooting Without Diagnostics

Solving Display Problems (Continued)

Problem

Cause

Solution

Power LED flashes Red six
times, once every second,
followed by a two second
pause, and the computer
beeps six times.

Pre-video graphics
error.

For systems with a graphics card:
1. Reseat the graphics card.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated
graphics, replace the system board.

Monitor does not function
properly when used with
energy saver features.

Monitor without energy
saver capabilities is

being used with energy
saver features enabled.

Disable monitor energy saver
feature.

Dim characters.

The brightness and
contrast controls are not
set properly.

Adjust the monitor brightness and
contrast controls.

Cables are not properly
connected.

Check that the graphics cable is
securely connected to the graphics
card and the monitor.

Blurry video or requested
resolution cannot be set.

If the graphics controller
was upgraded, the
correct video drivers
may not be loaded.

Install the video drivers included in
the upgrade kit.

Monitor is not capable
of displaying requested
resolution.

Change requested resolution.

The picture is broken up,
rolls, jitters, or flashes.

The monitor connections
may be incomplete or
the monitor may be
incorrectly adjusted.

1. Be sure the monitor cable is
securely connected to the
computer.

2. In a two-monitor system or if
another monitor is in close
proximity, be sure the monitors
are not interfering with each
other’s electromagnetic field by
moving them apart.

3. Fluorescent lights or fans may
be too close to the monitor.

Monitor needs to be
degaussed.

Degauss the monitor.

Vibrating or rattling noise

coming from inside a CRT
monitor when powered on.

Monitor degaussing coil
has been activated.

None. It is normal for the
degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from

inside a CRT monitor.

Electronic relays have
been activated inside

None. It is normal for some monitors
to make a clicking noise when

the monitor. turned on and off, when going in
and out of standby mode, and when
changing resolutions.
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Troubleshooting Without Diagnostics

Solving Display Problems (Continued)

Problem

Cause

Solution

High pitched noise coming
from inside a flat panel
monitor.

Brightness and/or
contrast settings are too

high.

Lower brightness and/or contrast
settings.

Fuzzy focus; streaking,
ghosting, or shadowing
effects; horizontal scrolling
lines; faint vertical bars; or
unable to center the picture
on the screen.

(flat panel monitors using
an analog VGA input
connection only)

Flat panel monitor’s
internal digital
conversion circuits may
be unable to correctly
interpret the output
synchronization of the
graphics card.

1. Select the monitor’s
Auto-Adjustment option in the
monitor’s on-screen display
menu.

2. Manually synchronize the Clock
and Clock Phase on-screen
display functions. Download
SoftPaq SP20930 or SP22333,
depending on the monitor, to
assist with the synchronization.

Certain typed symbols do
not appear correct.

The font you are using
does not support that
particular symbol.

Use the Character Map to locate the
and select the appropriate symbol.
Click Start > All Programs >
Accessories > System Tools >
Character Map. You can copy
the symbol from the Character Map
info a document.
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Solving Audio Problems

Solving Audio Problems

Problem

Cause

Solution

Sound does not come
out of the speaker or
headphones.

Software volume control
is turned down.

Double-click the Speaker icon on
the taskbar and use the volume
slider to adjust the volume.

The external speakers
are not turned on.

Turn on the external speakers.

External speakers
plugged into the wrong
audio jack.

See the sound card documentation
for proper speaker connection.

Audio cable not
connected.

Connect audio cable between CD
or DVD-ROM drive and the system
board.

Digital CD audio is not
enabled.

Enable digital CD audio:

1. From the Control Panel, select
System.

2. On the Hardware tab, click
the Device Manager button.

3. Right-click on the CD/DVD
device and select Properties.

4. On the Properties tab, make
sure “Enable digital CD

audio for this CD-ROM
device” is checked.

Headphones or devices
connected to the
line-out connector mute
the internal speaker.

Turn on and use headphones or
external speakers, it connected, or
disconnect headphones or external
speakers.

Volume is muted.

1. From the Control Panel
program, click Sound,
Speech and Audio
Devices, then click Sounds
and Audio Devices.

2. Click the Mute check box to
remove the check mark from

the box.

Computer is in

standby mode.

Press the power button to resume
from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold down the
power button for more than four seconds. Otherwise, the computer will shut down
and you will lose your data.
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Solving Audio Problems (Continued)

Problem Cause Solution

Noise or no sound comes 1. If using digital speakers that
out of the speakers or have a stereo jack and want the
headphones. system to auto-switch to digital,

use a stereo-to-mono adapter
to properly engage the

auto-sense feature or use the
multimedia device properties
to manually switch the audio
signal from analog to digital.

2. If the headphones have a mono
jack, use the multimedia device
properties o switch the system
to analog out.

@y, lfyou set di?ifcﬂ as the Output Mode, the internal speaker and external analog
speakers will no longer output audio until you switch back to an auto-sense or
analog mode.

If you set analog as the Output Mode, external digital speakers will not function
until you change the output mode back to an auto-sense or digital mode.

Sound cuts in and out. Processor resources are  Shut down all open
being used by other processor-intensive applications.
open applications.
Computer appears to be The hard disk may be 1. Before recording, make sure
locked up while recording  full. there is enough free space on
audio. the hard disk.

2. Try recording the audio file in a
compressed format.
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Solving Printer Problems

Solving Printer Problems

Problem

Cause

Solution

Printer will not print.

Printer is not turned on
and online.

Turn the printer on and make sure it
is online.

The correct printer
driver for the
application are not
installed.

1. Install the correct printer driver
for the application.

2. Try printing using the
MS-DOS command:
DIR C:\ > [printer port]

where [printer port] is the
address of the printer being
used. If the printer works, reload
the printer driver.

If you are on a network,
you may not have made
the connection to the
printer.

Make the proper network
connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.

The cables may not be
connected properly.

Reconnect all cables.

Printer prints garbled
information.

The correct printer
driver is not installed.

Install the correct printer driver for
the application.

The cables may not be
connected properly.

Reconnect all cables.

Printer memory may be
overloaded.

Reset the printer by turning it off for
one minute, then turn it back on.

Printer is offline.

The printer may be out
of paper.

1. Check the paper tray and refill it
if it is empty.

2. Select online.
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Solving Keyboard and Mouse Problems

Solving Keyboard Problems

Problem Cause Solution

Keyboard commands and  Keyboard connector 1. Turn off the computer.

typing are not recognized s not properly 2. Reconnect the keyboard to the

by the computer. connected. back of the computer and

restart the computer.

Program in use has Shut down the computer using
stopped responding the mouse and then restart the
to commands. computer.
Keyboard needs Replace the keyboard.
repairs.
Computer is in Press the power button to resume
standby mode. from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold down the
power button for more than four seconds. Otherwise, the computer will shut down
and you will lose your data.

Cursor will not move using  The Num Lock key Press the Num Lock key. The
the arrow keys on the may be on. Num Lock light should not be on if
keypad. you want fo use the arrow keys. The

Num Lock key can be disabled
(or enabled) in Computer Setup.

Mouse does not respond o Mouse connector is 1. Shut down the computer using
movement or is too slow. not properly plugged the keyboard.
into the back of the

2. Plug the mouse connector into

computer. the back of the computer (or the
keyboard) and restart the
computer.

Program in use has Shut down the computer using the

stopped responding keyboard and then restart the

to commands. computer.

Mouse needs repairs. Replace the mouse.

Computer is in Press the power button to resume

standby mode. from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold down the
power button for more than four seconds. Otherwise, the computer will shut down
and you will lose your data.

Mouse will only move Mouse roller ball is Remove roller ball cover from the
vertically or horizontally, or  dirty. bottom of the mouse and clean it.
movement is jerky.
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Solving Hardware Installation Problems

You may need to reconfigure the computer when you add or remove hardware, such as an
additional diskette drive. If you install a plug and play device, Windows XP automatically
recognize the device and configure the computer. If you install a non—plug and play device, you
must reconfigure the computer after completing installation of the new hardware. In Windows
XP, use the Add Hardware Wizard and follow the instructions that appear on the screen.

Solving Hardware Installation Problems

Problem

Cause

Solution

A new device is not
recognized as part of
the system.

Device is not seated or
connected properly.

Ensure that the device is properly
and securely connected and that
pins in the connector are not
bent down.

Cable(s) of new
external device are
loose or power cables
are unplugged.

Ensure that all cables are properly
and securely connected and that
pins in the cable or connector are
not bent down.

Power switch of new
external device is not
turned on.

Turn off the computer, turn on the
external device, then turn on the

computer to integrate the device

with the computer system.

When the system
advised you of changes
to the configuration, you
did not accept them.

Reboot the computer and follow the
instructions for accepting the
changes.

A plug and play board
may not automatically
configure when

added if the default
configuration conflicts
with other devices.

Use Windows XP Device Manager
to deselect the automatic settings for
the board and choose a basic
configuration that does not cause a
resource conflict. You can also use
Computer Setup to reconfigure or
disable devices to resolve the
resource conflict.

Computer will not start.

Wrong memory
modules were used in
the upgrade or memory
modules were installed
in the wrong location.

1. Review the documentation that
came with the system to
determine if you are using the
correct memory modules and to
verify the proper installation.

2. Observe the beeps and LED
lights on the front of the
computer. See Appendix C,
“POST Error Messages” to
determine possible causes.

360201-002
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Solving Hardware Installation Problems (Continued)

Problem

Cause

Solution

Power LED flashes Red five
times, once every second,
followed by a two second
pause, and the computer
beeps five times.

Memory is installed
incorrectly or is bad.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to
isolate the faulty module.

3. Replace third-party memory
with HP memory.

4. Replace the system board.

Power LED flashes Red six
times, once every second,
followed by a two second
pause, and the computer
beeps six times.

Video card is not seated
properly or is bad, or
system board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power
on the system.

2. Replace the graphics card.
3. Replace the system board.

For systems with integrated
graphics, replace the system board.
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Solving Network Problems

These guidelines do not discuss the process of debugging the network cabling.

Solving Network Problems

Problem

Cause

Solution

Woake-on-LAN feature is
not functioning.

Woake-on-LAN is not
enabled.

Use the Network control
application to enable
Woake-on-LAN.

Network driver does
not detect network
controller.

Network controller is

disabled.

Run Computer Setup and enable
network controller.

Incorrect network driver.

Check the network controller
documentation for the correct driver
or obtain the latest driver from the
manufacturer’'s Web site.

Network status link light
does not turn on or it
never flashes.

The network status
light should flash
w%wen there is
network activity.

No active network is
detected.

Check cabling and network
equipment for proper connection.

Network controller is not
set up properly.

Use the Network control
application to verify that the device
is working properly.

Network driver is not
properly loaded.

Reinstall network drivers.

System cannot autosense
the network.

Disable auto-sensing capabilities
and force the system into the correct
operating mode.

Diagnostics reports a
failure.

The cable is not securely
connected.

Ensure that both ends of the data
cable are securely connected.

The cable is attached to
the incorrect connector.

Ensure that the cable is attached to
the correct connector.

There is a problem with
the cable or a device at
the other end of the cable.

Ensure that the cable and device at
the other end are operating
correctly.

Network controller
interrupt is shared with
an expansion board.

Under the Computer Setup
Advanced menu, change the
resource settings for the board.

The network controller
is defective.

Replace the NIC.

Diagnostics passes, but
the computer does not
communicate with the
network.

Network drivers are

not loaded, or driver
parameters do not match
current configuration.

1. Make sure the network drivers
are loaded and that the driver
parameters match the
configuration of the network
controller.

2. Make sure the correct network
client and protocol is installed.
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Solving Network Problems (Continued)

Problem

Cause

Solution

Diagnostics passes, but
the computer does not
communicate with the
network. (continued)

The network controller
is not configured for this
computer.

Select the Network icon in the
Control Panel and configure the
network controller.

Network controller
stopped working when
an expansion board was
added to the computer.

Network controller
interrupt is shared with an
expansion board.

Under the Computer Setup
Advanced menu, change the
resource settings for the board.

The network controller
requires drivers.

Verity that the drivers were not
accidentally deleted when the
drivers for a new expansion board
were installed.

The expansion board
installed is a network card
(NIC) and conflicts with
the embedded NIC.

Under the Computer Setup
Advanced menu, change the
resource settings for the board.

Network controller stops
working without apparent
cause.

The files containing the
network drivers are
corrupted.

Reinstall the network drivers, using
the Restore Plus! CD.

The cable is not securely
connected.

Ensure that both ends of the cable
are securely attached to the correct
devices.

The network controller is
defective.

Replace the NIC.

New network card will
not boot.

New network card may be
defective or may not meet
industry-standard
specifications.

Install @ working, industry-standard
NIC, or change the boot sequence
to boot from another source.

Cannot connect fo
network server when
attempting Remote
System Installation.

The network controller is
not configured properly.

Verity Network Connectivity, that a
DHCP Server is present, and that
the Remote System Installation
Server contains the NIC drivers for
your NIC.

System setup utility
reports unprogrammed
EEPROM.

Unprogrammed EEPROM.

Flash the ROM.
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Solving Memory Problems

CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and
non-ECC memory. Otherwise, the system will not boot the operating system.

Solving Memory Problems

Problem

Cause

Solution

System will not boot or
does not function properly
after installing additional
memory modules.

Memory module is not
the correct type or
speed or the new
memory module is not
seated properly.

Replace module with the correct
industry-standard device for the
computer.

On some models, ECC and non-ECC

memory modules cannot be mixed.

Out of memory error.

Memory configuration
may not be set up
correctly.

Use the Device Manager to check
memory configuration.

You have run out of
memory to run the
application.

Check the application
documentation to determine the
memory requirements.

Memory count during POST

is wrong.

The memory modules
may not be installed
correctly.

Check that the memory modules
have been installed correctly and
that proper modules are used.

Insufficient memory error
during operation.

Too many Terminate
and Stay Resident
programs (TSRs) are
installed.

Delete any TSRs that you do
not need.

You have run out of
memory for the
application.

Check the memory requirements for
the application or add more
memory to the computer.

Power LED flashes Red five
times, once every second,
followed by a two second
pause, and the computer
beeps five times.

Memory is installed
incorrectly or is bad.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to
isolate the faulty module.

3. Replace third-party memory
with HP memory.

4. Replace the system board.
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Solving Processor Problems

Solving Processor Problems

Problem

Cause

Solution

Poor performance is
experienced.

Processor is hot.

1

. Make sure the airflow to the

computer is not blocked.

. Make sure the fans are

connected and working
properly (some fans only
operate when needed).

. Make sure the processor

heatsink is installed properly.

Power LED is Red and

Processor is not seated

. Check to see that the processor

stays on. properly or not is present.
installed. 2. Reseat the processor.
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Solving CD-ROM and DVD Problems

Solving CD-ROM and DVD Problems

Problem

Cause

Solution

System will not boot from
CD-ROM or DVD drive.

The CD-ROM or DVD
boot is not enabled
through the Computer
Setup utility.

Run the Computer Setup utility and
enable booting to removable media
and verify boot order settings.

Non-bootable CD in
drive.

Try a bootable CD in the drive.

CD-ROM or DVD devices
are not detected or driver is
not loaded.

Drive is not connected
properly or not properly
configured.

1. Reconnect power and data
cables to the drive.

2. Install correct device driver.

Movie will not play in the

DVD drive.

Movie may be
regionalized for a
different country.

See the documentation that came

with the DVD drive.

Decoder software is not
installed.

Install decoder software.

Cannot eject compact disc
(tray-load unit).

Disc not properly seated
in the drive.

1. Turn off the computer and insert
a thin metal rod into the
emergency eject hole and push
firmly.

2. Slowly pull the tray out from the
drive until the tray is fully
extended, then remove the disc.

CD-ROM, CD-RW,
DVD-ROM, or DVD-R/RW
drive cannot read a disc or
takes too long to start.

CD has been inserted
upside down.

Re-insert the CD with the label
facing up.

The DVD-ROM drive
takes longer to start
because it has to
determine the type of
media played, such as
audio or video.

Wait at least 30 seconds to let the
DVD-ROM drive determine the type
of media being played. If the disc
still does not start, read the other
solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD
cleaning kit.

Windows does not
detect the CD-ROM or
DVD-ROM drive.

1. Use Device Manager to remove
or uninstall the device in
question.

2. Restart the computer and let
Windows detect the device.

D-22

360201-002

Service Reference Guide, dc5000



Troubleshooting Without Diagnostics

Solving CD-ROM and DVD Problems (Continved)

Problem

Cause

Solution

Recording audio CDs is

difficult or impossible.

Wrong or poor quality
media type.

1. Try using a slower recording
speed.

2. Verity that you are using the
correct media for the drive.

3. Try a different brand of media.
Quality varies widely between

manufacturers.
Solving Drive Key Problems
Solving Drive Key Problems
Problem Cause Solution

Drive key is not seen as a
drive letter in Windows XP.

The drive letter after the
last physical drive is not
available.

Change the default drive letter for
the Drive key in Windows XP.

The computer boots to DOS
after making a bootable
Drive key.

Drive key is bootable.

Install the Drive key after the
operating system boots.

Solving Internet Access Problems

Solving Internet Access Problems

Problem

Cause

Solution

Unable to connect to the
Internet.

Internet Service Provider
(ISP) account is not set

up properly.

Verify Internet settings or contact the
ISP for assistance.

Modem is not set up
properly.

Reconnect the modem. Verify the
connections are correct using the
quick setup documentation.

Web browser is not set
up properly.

Verify that the Web browser is
installed and set up to work with
your ISP.

Cable/ DSL modem is
not plugged in.

Plug in cable/DSL modem. You
should see a “power” LED light on
the front of the cable/DSL modem.
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Solving Internet Access Problems (Continued)

Problem Cause Solution

Unable to connect to the Cable/DSL service is Try connecting fo the Internet at a

Internet. (continued) not available or has later time or contact your ISP. (If the
been interrupted due to  cable/DSL service is connected, the
bad weather. “cable” LED light on the front of the

cable/DSL modem will be on.)

The CAT5 10/100 Connect the CAT5 10/100 cable
cable is disconnected.  between the cable modem and the

computers’s RJ-45 connector. (If the
connection is good, the “PC” LED
light on the front of the cable/DSL
modem will be on.)

IP address is not Contact the ISP for the correct IP
configured properly. address.

Cookies are corrupted. ~ Windows XP

1. Select Start > Control
Panel.

2. Double-click Internet
Options.

3. On the General tab, click the
Delete Cookies button.

Cannot automatically You must log on to the  Log on to the ISP and launch the
launch Internet programs. ISP before some desired program.
programs will start.
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Solving Internet Access Problems (Continued)

Problem

Cause

Solution

Internet takes too long to
download Web sites.

Modem is not set up
properly.

Verify that the correct modem speed
and COM port are selected.

For Windows XP

1.

Select Start > Control
Panel.

Continue with step #2

2.
3.
4.

Double-click System.
Click the Hardware tab.

In the Device Manager area,
click the Device Manager
button.

. Double-click Ports (COM &

LPT).

. Right-click the COM port your

modem uses, then click
Properties.

. Under Device status, verify

that the modem is working
properly.

. Under Device usage, verify

the modem is enabled.

. If there are further problems,

click the Troubleshoot button
and follow the on-screen
instructions.
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Front Panel LEDs and Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before
or during POST that do not necessarily have an error code or text message associated with them.

% If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the
computer and refer to the following table to determine the front panel LED codes.

% Recommended actions in the following table are listed in the order in which they should be

performed.

Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause = Recommended Action
Green Power None Computer on. None
LED On.
Green Power None Computer in None
LED flashes Suspend to RAM
every two mode (select
seconds. models only) or
normal Suspend
mode.
Green Power None Computer in None

LED flashes four
times, once per

Suspend
to Disk or

second. “Hibernate” mode.

Red Power LED None Processor thermal 1. Ensure that the computer air vents are

flashes two protection not blocked and the processor

times, once activated: cooling fan is running.

?very second, A fan may be 2. Open hood, press power button, and

ollowed by a blocked or not see if the processor fan spins. If the

two second turning. processor fan is not spinning, make

pause. OR sure the fan's cable is plugged onto
The heatsink /fan the system board header. Ensure the

assembly is not
properly attached
to the processor.

fan is fully/properly seated or
installed.

3. It fan is plugged in and seated
properly, but is not spinning, then
replace processor fan.

4. Reseat processor heatsink and verify
that the fan assembly is properly
attached.

5. Contact an authorized reseller or
service provider.
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Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause = Recommended Action
Red Power LED None Processor not 1. Check to see that the processor is
stays on. installed (not an present.
OR indicator of bad 2. Reseat the processor.
Red Power LED processor).
flashes three
times, once
every second,
followed by a
two second
pause.
Red Power LED None Power failure 1. Check that the voltage selector,
flashes once (power supply is located on the rear of the power
every two overloaded). supply, is set to the appropriate
seconds. voltage. Proper voltage setting
OR depends on your region.
Red Power LED 2. Open the hood and ensure the 4-wire
flashes four power supply cable is seated into the
times, once connector on the system board.
every second, 3. Check if a device is causing the
followed by a problem by removing ALL attached
two second devices (such as hard, diskette, or
pause. optical drives, and expansion cards).
Power on the system. If the system
enters the POST, then power off and
replace one device at a time and
repeat this procedure until failure
occurs. Replace the device that is
causing the failure. Continue adding
devices one at a time to ensure all
devices are functioning properly.
4. Replace the power supply.
5. Replace the system board.
Red Power LED 5 Pre-video memory 1. Reseat DIMMs. Power on the system.
f!oshes five error 2. Replace DIMMs one at a time to
times, once isolate the faulty module.
every second, . .
followed by a 3. Replace third-party memory with HP
two second memory.
pause. 4. Replace the system board.
Red Power LED 6 Pre-video graphics  For systems with a graphics card:

flashes six times,
once every
second,
followed by a
two second
pause.

error.

1

2.
3.

. Reseat the graphics card. Power on

the system.
Replace the graphics card.

Replace the system board.

For systems with integrated graphics,
replace the system board.
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Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps

Possible Cause

Recommended Action

Red Power LED 7
flashes seven

times, once

every second,
followed by a

two second

pause.

System board
failure (ROM
detected failure
prior to video).

Replace the system board.

Red Power LED 8
flashes eight

times, once

every second,
followed by a

two second

pause.

Invalid ROM based

on bad checksum.

1.

Reflash the ROM using a ROMPaq
diskette. See the “ROM Flash” section
of the Desktop Management Guide.

2. Replace the system board.

System does not  None
power on and
LEDs are not

flashing.

System unable to
power on.

Press and hold the power button for less
than 4 seconds. If the hard drive LED turns
green, then:

1.

Check that the voltage selector,
located on the rear of the power
supply, is set fo the appropriate
voltage. Proper voltage setting
depends on your region.

. Remove the expansion cards one at a

time until the 3.3 V_aux light on the
system board turns on.

3. Replace the system board.

OR

Press and hold the power button for less
than 4 seconds. If the hard drive LED does
not turn on green then:

1.

Check that the unit is plugged into a
working AC outlet.

. Open hood and check that the power

button harness is properly connected
to the system board.

. Check that both power supply cables

are properly connected to the system

board.

. Check to see if the 3.3 V_aux light on

the system board is turned on. If it is
turned on, then replace the power
button harness.

. If the 3.3 V_aux light on the system

board is not turned on, then replace
the power supply.

. Replace the system board.
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System Board and Riser Board Reference

Designators

These reference designators are used on the HP Compaq Business Desktop dc5000 series

computer.
Designator Component
CR1 LED - 5V Aux
E49 Clear Password header/jumper
J20- 22 PCl slots
P1 Power supply connector
P3 VCCP 12V header
P5 Main Power/HDD LED connector
P6 Speaker connector
P7 Audio connector (from CD-ROM)
P8 Primary chassis fan connector
P10 Diskette drive connector
P11 Second Audio connector
P14 Boot block write jumper
P16 Fan command/fan sink header
P20 Primary IDE connector
P21 Secondary IDE connector
P23 Header for front audio panel
P24 Header for front panel USB
P54 Second serial port
P70 Primary (CPU) fan header for fansink
SW50 Clear CMOS switch/push button
XBT1 Battery socket
XMM1 Memory slot 1
XMM?2 - XMM4 Following memory slots
XUl Primary processor socket
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Memory

AMD-Based Systems

Computers equipped with AMD-based processors come with Double Data Rate-Synchronous
Dynamic Random Access Memory (DDR-SDRAM) Dual Inline Memory Modules (DIMMs).

The memory sockets on the system board can be populated with industry-standard DIMMs.
These memory module slots are populated with at least one pre installed memory module. To
achieve the maximum memory support, you may be required to replace the pre installed DIMM
with a higher capacity DIMM.

If you are adding a second DIMM, it is recommended that you add a DIMM identical to the
preinstalled DIMM in order to achieve a higher performing dual channel mode. The system
board must be populated with DIMMs of identical type and speed for the system to operate in
dual channel mode.

For proper system operation, if the system supports DDR-SDRAM DIMMSs, the DIMMs must be
industry-standard 184-pin, unbuffered PC 1600 200 MHz- or PC 2100 266 MHz-compliant CAS
Latency 2 or 2.5 (CL =2 or CL = 2.5), or PC 2700 333 MHz-compliant CAS Latency 2.5 (CL =
2.5) 2.5 volt DDR-SDRAM DIMMs. They must also contain the mandatory Joint Electronic
Device Engineering Council (JEDEC) Serial Presence Detect (SPD) information. DIMMs
constructed with x4 SDRAM are not supported; the system will not start using unsupported
DIMMs.

Intel-Based Systems

Computers equipped with Intel-based processors come with double data rate synchronous
dynamic random access memory (DDR-SDRAM) dual inline memory modules (DIMMs).

The memory sockets on the system board can be populated with up to four industry-standard
DIMMs. These memory module slots are populated with at least one preinstalled memory
module. To achieve the maximum memory support, you can populate the system board with up
to 4GB of memory configured in a high-performing dual channel mode.

For proper system operation, if the computer supports DDR-SDRAM DIMMs, the DIMMs must
be industry-standard 184-pin, unbuffered PC2100 266 MHz-, PC2700 333 MHz-, or PC3200
400 MHz-compliant, 2.5 volt DDR-SDRAM DIMMs. The DDR-SDRAM DIMMs must also:

B support CAS latency 2, 2.5, or 3 (CL =2, CL =2.5, CL=3)

B contain the mandatory JEDEC SPD information

In addition, the computer supports:

B 128Mbit, 256Mbit, and 512Mbit non-ECC memory technologies
B single-sided and double-sided DIMMS

B DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM
are not supported
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The following processor bus frequencies are required for the system to run at the supported
memory frequencies.

Memory Frequency Required Processor Bus Frequency

266 MHz 400 MHz, 533 MHz, or 800 MHz
333 MHz 533 MHz or 800 MHz
400 MHz 800 MHz

If a memory frequency is paired with an unsupported processor bus frequency, the system will
run at the highest supported memory speed. For example, if a 333 MHz DIMM is paired with a
400 MHz processor bus, the system will run at 266 MHz, the highest supported memory speed.

% The system will not start if you install unsupported DIMMs.

DIMM Sockets

There are four DIMM sockets on the system board, with two sockets per channel. The sockets
are labeled XMM1, XMM2, XMM3, and XMM4. Sockets XMM1 and XMM?2 operate in
memory channel A. Sockets XMM3 and XMM4 operate in memory channel B.

The system board shown below may be different from the one in your computer.

Item Description Socket Color
(1) DIMM socket XMM1, Channel A Black
(2] DIMM socket XMM2, Channel A Blue
(3] DIMM socket XMM3, Channel B Black
(4] DIMM socket XMM4, Channel B Blue
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The system will automatically operate in single channel mode or a higher-performing dual
channel mode, depending on how the DIMMs are installed.

B Insingle channel mode, the maximum operational speed is determined by the slowest DIMM
in the system. For example, if the system is populated with a DIMM that is 266 MHz and a
second DIMM that is 333 MHz, the system will run at the slower of the two speeds.

B In dual channel mode, the DIMM pairs must be identically matched. DIMMs in the XMM1
and XMM3 black sockets must be identical; DIMMSs in the XMM?2 and XMM4 blue sockets
must also be identical. Therefore, if you have one preinstalled DIMM in socket XMM1 and
are adding a second DIMM, it is recommended that you install an identical DIMM into the
XMM3 socket.
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4-pin power pin assignments A—6 changing operating systems, important information
20-pin power pin assignments A—6 3-7

3.5" drive bezel, pT removal and replacement 6-9 changing password 3—11

5.25" drive bezel, uT removal and replacement 68  chassis fan

A uT removal and replacement 6-20

SFF removal and replacement 7-23
chassis types, illustrated 5-1
cleaning

computer 5-5

keyboard 5-6

monitor 5-6

access panel, uT removal and replacement 6—4
access to computer, controlling 3-8

advanced, Computer Setup heading 2-9

asset tracking 3-8

ATA/ATAPI (IDE) drive cable pin assignments

A6 mouse 5-6
B clearing password 3-13
battery cloning tools, software 3—1
disposal 5-8 computer
uT removal and replacement 6-27 cleaning 5-5
real-time clock D-2 computer pauses D-2
SFF removal and replacement 7-24 Computer Setup
blank screen D-9 heading
bootable disk, important information 3—17 advanced 2-9
C file 24
cable security 2—6
storage 2—4

uT removal and replacement 615
proper handling 5-8
SFF removal and replacement 7-15

utilities 2-3
Computer Setup Utilities 3—6
Configuration Record Utility 2—-16

cable lock IS
uT 6-2 configuring power button 3—-6
SEE 7-2 connector pin assignments A—1 to A—6

controlling access to computer 3—8
country-specific power cord set requirements B-2
customizing software 3—1

cable lock provision 3-17
cable select drive 4-1
categories, Diagnostics for Windows 2—-13

cautions D
AC power 5-1 date and time display D-2
adding devices 1-1 deleting password 3-12
batteries 5—8 delimiter characters, table 3—13
cables 5-8 deployment tools, software 3—1
cooling fan 5-7 device drivers, installing/upgrading 1-1
installation 1-1 diagnostic tool for hard drives 3-18
keyboard cleaning 5-6 Diagnostics for Windows
keyboard keys 5-6 categories 2—-13
protecting ROM 34 detecting 2—12
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installing 2—-13
Menu Bar 2-14
overview 2—12
running tests 2—15
disassembly preparation
uT 6-1
SFF 7-1
disconnecting
uTdiskette drive cable 6-15
uT hard drive cable 6-16
uT optical drive cable 6-15
disk, cloning 3-1
diskette drive bezel
uT removal and replacement 6-9
SFF removal and replacement 7-6
diskette drive cable
uT connecting 6-18
uT disconnecting 615
drive
cable select 4—1
capacities 4—7
device designation 4—1
uT removal and replacement 615
partition size 4—7
replacement type 4—6
drive positions
uT 6-14
SFF 7-11
drive, protecting 3—18
dual-state power button 3—-6

electrostatic discharge. See ESD
energy savings, settings for 3—7
entering

power-on password 3—11

setup password 3—11
error messages, POST C-1 to C-7
ESD (electrostatic discharge)

information 5-3

materials and equipment 5—4

preventing damage 5-3
Ethernet

AUI pin assignments A-2

BNC pin assignments A—1

RJ-45 pin assignments A-2
expansion card

uT removal and replacement 612

SFF removal and replacement 7-9
expansion slot cover

uT removal and replacement 611

SFF, removal and replacement 7—8
external 3.5-inch drive

SFF removal and replacement 7-16
external security

uT 6-2

SFF 7-2

F
FailSafe Boot Block ROM 3-5
fan
UT chassis removal and replacement 6-20
power supply 5-7
fan, SFF chassis 7-23
fault notification 3—18
file, Computer Setup heading 2—4
fingerprint identification technology 3-18
formatting disk, important information 3—17
front bezel
uT removal and replacement 65
SFF removal and replacement 7-5
front I/O devices
uT removal and replacement 622
SFF removal and replacement 7-20
front I/O panel
uT removal and replacement 6-21

G
grounding methods 54

H

hard drive

proper handling 5-8

SFF removal and replacement 7—18
hard drive cable

uT connecting 6-19

uT disconnecting 6-16
hard drives, diagnostic tool 3—18
headphone pin assignments A—4
heatsink

uT removal and replacement 6-25

SFF removal and replacement 7-27
HP Client Manager 3-2
HP software. See software

IDE drive cable pin assignments A—6

infrared (IR) transceiver, external, pin assignments
A-5

initial configuration 3—1

installing Diagnostics for Windows 2—13

Internet addresses, See Web sites
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invalid system ROM 3-5
IR transceiver. See infrared (IR) transceiver

J

jumper
resetting password 3—13
settings D7

K

keyboard

cleaning 5-6

pin assignments A—1
keyboard delimiter characters, national 3—13
keyboard lights, ROM, table 3-6

L

LEDs, blinking power D-26
line-in audio pin assignments A—4
line-out audio pin assignments A—4

M

Master Boot Record Security, setting 3—16
memory
dual channel mode F-3
uT removal and replacement 6-10
SFF removal and replacement 7-7
menu bar, Diagnostics for Windows 2—14
microphone pin assignments A—3
puT
3.5" drive bezel removal and replacement 6-9
5.25" drive bezel removal and replacement 6—8
access panel removal and replacement 6—4
battery removal and replacement 627
cable lock 6-2
chassis fan removal and replacement 620
chassis, illustrated 5—1
disassembly preparation 61
diskette drive bezel removal and replacement
6-9
diskette drive cable connecting 6—18
diskette drive cable disconnecting 6-15
drive positions 614
drive removal and replacement 6-15
expansion card removal and replacement 6—12
expansion slot cover 6-11
external security 6-2
front bezel removal and replacement 6-5
front I/O devices removal and replacement 622
front I/O panel removal and replacement 6-21
hard drive cable connecting 6—19
hard drive cable disconnecting 6-16
heatsink removal and replacement 625

memory removal and replacement 610
optical drive cable connecting 6—18
optical drive cable disconnecting 6—15
padlock 6-3
PCI expansion card removal and replacement
6-12
power supply removal and replacement 632
power switch assembly removal and
replacement 6-23
preparation for disassembly 6—1
processor removal and replacement 6-25
speaker removal and replacement 6-31
system board removal and replacement 6-26
monitor
blank screen D-9
blurry video D-10
checking connections D—1
cleaning 5-6
dim characters D-10
pin assignments A-5
mouse
cleaning 5-6
pin assignments A—1

national keyboard delimiter characters 3—13

o
operating systems, important information about
3-7
optical drive cable
uT connecting 6-18
uT disconnecting 615
SFF connecting 7-15
SFF removal and replacement 7-13

P
padlock

uT 6-3

SFF 7-3
parallel interface pin assignments A-3
partitioning disk, important information 3—-17
password

changing 3-11

clearing 3—-13

deleting 3-12

jumper, resetting 3—13

power-on 2—-1, 3-11

resetting jumper 3—13

setup 3-10, 3-11
password security 3—10
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PCI expansion card

uT removal and replacement 6—12

SFF removal and replacement 7-8
POST (Power-On Self-Test) 2—1
POST error messages C—1 to C-7
power button

configuring 3-6

dual-state 3—6
power cord set requirements

country specific B-2

general B—1
Power Management 3—7
power supply

fan 5-7

uT removal and replacement 6-32

SFF removal and replacement 7-29
power supply, surge-tolerant 3—18
power switch assembly

uT removal and replacement 6-23

SFF removal and replacement 7-21
power-on password 2—1

changing 3-11

deleting 3—-12

entering 3—11
Power-On Self-Test (POST) 2-1
Preboot Execution Environment (PXE) 3-2
preinstalled software image 3—1
primary hard drive, SFF removal and relacement

7-18

problems, solving

audio D-12

CD-ROM and DVD D-22

diskette D-5

display D-9

drive key D-23

hard drive D-6

installing hardware D-16

Internet access D-23

keyboard D-15

memory D-20

network D—18

optical drives D-22

power supply D—4

printer D-14
processor

uT removal and replacement 6-25

SFF removal and replacement 7-27
protecting hard drive 3-18
protecting ROM, caution 3—4
protecting software 2—17

PXE (Preboot Execution Environment) 3-2

recovering system 3-5

recovery, software 3—1

Remote Diagnostics Enabling Agent 2—17
Remote ROM Flash 3-4

remote setup 3-2

Remote System Installation, accessing 3-2
removal and replacement

uT 3.5" drive bezel 6-9

uT 5.25" drive bezel 6-8

uT access panel 64

uT battery 6-27

uT cable lock 6-2

uT chassis fan 6-20

uT diskette drive bezel 6-9
uT drive 6-15

uT expansion card 6-12

uT front bezel 6-5

uT front I/O devices 6-22

uT front I/O panel 6-21

uT heatsink 6-25

uT memory 6-10

uT padlock 6-3

uT PCI expansion card 6-12
uT power supply 6-32

uT power switch assembly 6-23
uT processor 6-25

uT speaker 6-31

uT system board 6-26

SFF battery 7-24

SFF cable lock 7-2

SFF chassis fan 7-23

SFF diskette drive bezel 7-6
SFF expansion card 7-9

SFF expansion slot cover 7-8
SFF external 3.5-inch drive 7-16
SFF front bezel 7-5

SFF front drive bezel 7-6
SFF front I/O devices 7-20
SFF heatsink 7-27

SFF memory 7-7

SFF optical drive 7-13

SFF padlock 7-3

SFF PCI expansion card 7-8
SFF power supply 7-29

SFF power switch assembly 7-21
SFF primary hard drive 7-18
SFF processor 7-27
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SFF speaker 7-28
SFF system board 7-22
required tools and software 5-7
resetting password jumper 3—13
restoring software 2—18
riser board designators E-1
ROM keyboard lights, table 3—6
ROM, invalid 3-5
ROM, upgrading 3—4
running tests,Diagnostics for Windows 2-15

S

safety precautions, cleaning 5-5
saving energy 3—7
screws, correct size 5-7
SCSI pin assignments A—4
SDRAM (synchronous dynamic random access
memory) F-1
security
Computer Setup heading 2-6
uT 6-2
SFF 7-2
security features, table 3-8
security settings, setup of 3-8
security, master boot record 3—16
serial interface pin assignments A—3
service considerations 5—7
setting
setup password 3-10, 3-11
timeouts 3—7
setup
initial 3-1
replicating 3-6
software 1-2
windows 1-1
setup password
changing 3-11
deleting 3—-12
entering 3—-11
setting 3—10
SFF
battery removal and replacement 7-24
cable lock 7-2
chassis fan removal and replacement 7-23
disassembly preparation 7-1
diskette drive bezel removal and replacement
7-6
drive cable removal and replacement 7—15
drive positions 7-11
expansion card removal and replacement 7-9

external 3.5-inch drive removal and replacement
7-16
external security 7-2
front bezel removal and replacement 7-5
front drive bezel removal and replacement 7-6
front I/O devices removal and replacement 7-20
memory removal and replacement 7-7
optical drive removal and replacement 7-13
padlock 7-3
PCI expansion card removal and replacement
7-8
power supply removal and replacement 7-29
power switch assembly removal and
replacement 7-21
preparation for disassembly 7—1
speaker removal and replacement 7-28
system board removal and replacement 7-22
software
asset tracking 3-8
Computer Setup Utilities 2—1, 3-6
Drive Protection System 3-18
FailSafe Boot Block ROM 3-5
Fault Notification and Recovery 3-18
integration 3—1
Master Boot Record Security 3—16
Power Management 3—7
protecting 2—17
recovery 3-1
Remote ROM Flash 3—4
Remote System Installation 32
required 5-7
restoring 2—18
setup 1-2
System Software Manager 3-3
updating multiple machines 3-3
spare part number
screwdriver with bits 5-7
wrench, tamper resistant 5—7
speaker
uT removal and replacement 6-31
SFF removal and replacement 7-28
SSM (System Software Manager) 3-3
static electricity 5-3
storage, Computer Setup heading 2—4
surge-tolerant power supply 3—18
system board
designators E—1
uT removal and replacement 6-26
SFF removal and replacement 7-22
system recovery 3-5
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System Software Manager (SSM) 3-3
T

timeouts, setting 3—7
tools, required 5-7

U

Ultra SCSI pin assignments A—5
upgrading ROM 34

URLSs (Web sites). See Web sites
USB pin assignments A-3

w
Wake-on-LAN feature D-18
warnings, battery 5—8
Web sites
Altiris 3-3
Diagnostics for Windows 2—13
HP 1-2, 2-17, 3-7
HP Client Manager 3-2
HP Proactive Notification 3—4
HP Security technology 3-18
HP support 2-13
HPQ Flash 3—4
PC Deployment 3-1
Remote Diagnostics Enabling Agent 2—17
Remote ROM Flash 3—4
ROMPaq images 3—4
Subscriber’s Choice 3—4
System Software Manager 3-3, 3—6
System Software Manager setup passwords 3—4
World Wide Web addresses. See Web sites
wrench, tamper-resistant 5—7

Index-6 360201-002

Service Reference Guide, dc5000



	Contents
	Installing the Operating System
	1.0.1 Installing or Upgrading Device Drivers
	1.0.2 Creating a Bootable Diskette or USB Flash Media Device
	1.1 HP Software

	Setup Utilities and Diagnostics Features
	2.1 Power-On Self-Test (POST)
	2.2 Computer Setup Utilities
	2.2.1 Using Computer Setup (F10) Utilities
	2.2.2 Computer Setup Menu

	2.3 Diagnostics for Windows
	2.3.1 Detecting Diagnostics for Windows
	2.3.2 Installing Diagnostics for Windows
	2.3.3 Using Categories in Diagnostics for Windows
	Menu Bar-File, Categories, Navigation, Level, Tab, Help

	2.3.4 Running Diagnostic Tests in Diagnostics for Windows

	2.4 Configuration Record
	2.4.1 Installing Configuration Record
	2.4.2 Running Configuration Record

	2.5 Remote Diagnostics Enabling Agent
	2.5.1 Installing or Upgrading Remote Diagnostics Enabling Agent
	2.5.2 Running the Remote Diagnostics Enabling Agent

	2.6 Protecting the Software
	2.7 Restoring the Software

	Desktop Management
	3.1 Initial Configuration and Deployment
	3.2 Remote System Installation
	3.3 Software Updating and Management
	3.3.1 HP Client Manager Software
	3.3.2 Altiris Client Management Solutions
	3.3.3 System Software Manager
	3.3.4 Proactive Change Notification (PCN)
	3.3.5 Subscriber’s Choice

	3.4 ROM Flash
	3.4.1 Remote ROM Flash
	3.4.2 HPQ Flash
	3.4.3 FailSafe Boot Block ROM
	3.4.4 Replicating the Setup
	3.4.5 Dual-State Power Button
	3.4.6 Power Management
	3.4.7 World Wide Web Site
	3.4.8 Building Blocks and Partners

	3.5 Asset Tracking and Security
	3.5.1 Password Security
	3.5.2 Establishing a Setup Password Using Computer Setup
	3.5.3 Establishing a Power-On Password Using Computer Setup
	Entering a Power-On Password
	Entering a Setup Password
	Changing a Power-On or Setup Password
	Deleting a Power-On or Setup Password
	National Keyboard Delimiter Characters
	Clearing Passwords

	3.5.4 DriveLock
	Using DriveLock
	DriveLock Applications

	3.5.5 Master Boot Record Security
	3.5.6 Before You Partition or Format the Current Bootable Disk
	3.5.7 Cable Lock Provision
	3.5.8 Fingerprint Identification Technology

	3.6 Fault Notification and Recovery
	3.6.1 Drive Protection System
	3.6.2 Surge-Tolerant Power Supply
	3.6.3 Thermal Sensor


	Ultra ATA Drive Guidelines and Features
	4.1 Ultra ATA Jumpers
	4.2 Ultra ATA Cables
	4.2.1 Cable Layout
	Single-Drive Cable
	Two-Drive Cable


	4.3 Drive Installation Guidelines
	4.3.1 Device Classes
	General Attach Guidelines

	4.3.2 Attach Sequence Rules by Class Priority
	4.3.3 Attach Sequence Worksheet
	Example 1: Three Device Installation Sample
	Example 2: Four Device Installation Sample

	4.3.4 Additional Drive Application Notes

	4.4 SMART
	4.5 Drive Capacities

	Identifying the Chassis, Routine Care, and Disassembly Preparation
	5.1 Chassis Designations
	5.1.1 Microtower (µT)
	5.1.2 Small Form Factor (SFF)

	5.2 Electrostatic Discharge Information
	5.2.1 Generating Static
	5.2.2 Preventing Electrostatic Damage to Equipment
	5.2.3 Personal Grounding Methods and Equipment
	5.2.4 Grounding the Work Area
	5.2.5 Recommended Materials and Equipment

	5.3 Routine Care
	5.3.1 General Cleaning Safety Precautions
	5.3.2 Cleaning the Computer Case
	5.3.3 Cleaning the Keyboard
	5.3.4 Cleaning the Monitor
	5.3.5 Cleaning the Mouse

	5.4 Service Considerations
	5.4.1 Power Supply Fan
	5.4.2 Tools and Software Requirements
	5.4.3 Screws
	5.4.4 Cables and Connectors
	5.4.5 Hard Drives
	5.4.6 Lithium Coin Cell Battery


	Removal and Replacement Procedures- Microtower (µT) Chassis
	6.1 Preparation for Disassembly
	6.2 External Security Devices
	6.2.1 Installing a Cable Lock
	6.2.2 Installing a Padlock

	6.3 Access Panel
	6.4 Front Bezel
	6.5 Front Drive Bezels
	6.5.1 5.25" Drive Bezel Blank
	6.5.2 Diskette Drive Bezel
	6.5.3 3.5" Drive Bezel Blank

	6.6 Memory Modules
	6.7 Expansion Cards
	6.7.1 Expansion Slot Cover
	6.7.2 PCI Expansion Card

	6.8 Drives
	6.8.1 Drive Positions
	6.8.2 Removing a Drive
	Disconnecting Optical Drive Cables
	Disconnecting Diskette Drive Cables
	Disconnecting Hard Drive Cables
	Releasing the Drives

	6.8.3 Installing a Drive
	Connecting Optical Drive Cables
	Connecting Diskette Drive Cables
	Connecting Hard Drive Cables


	6.9 Chassis Fan
	6.10 Front I/O Panel Housing Assembly
	6.11 Front I/O Devices
	6.12 Power Switch Assembly
	6.13 Processor and Heatsink
	6.14 System Board
	6.15 Battery
	6.15.1 Type 1 Battery Holder
	6.15.2 Type 2 Battery Holder
	6.15.3 Type 3 Battery Holder

	6.16 Speaker
	6.17 Power Supply

	Removal and Replacement Procedures- Small Form Factor (SFF) Chassis
	7.1 Preparation for Disassembly
	7.2 External Security Devices
	7.2.1 Cable Lock
	7.2.2 Padlock

	7.3 Computer Access Panel
	7.4 Front Bezel
	7.5 Front Drive Bezels
	7.6 Memory Modules
	7.7 PCI Expansion Card
	7.8 Drives
	7.8.1 Drive Positions
	7.8.2 Cable Routing
	7.8.3 Optical Drive
	7.8.4 External 3.5-inch Drive
	7.8.5 Primary Hard Drive

	7.9 Front I/O Devices
	7.10 Power Switch Assembly
	7.11 System Board
	7.12 Chassis Fan
	7.13 Battery
	7.13.1 Type 1 Battery Holder
	7.13.2 Type 2 Battery Holder

	7.14 Processor and Heatsink
	7.15 Speaker
	7.16 Power Supply

	Connector Pin Assignments
	Power Cord Set Requirements
	POST Error Messages
	Troubleshooting Without Diagnostics
	System Board and Riser Board Reference Designators
	Memory
	Index

